Copyright:

TeachUcomp, Inc. provides this product “as is”, makes no representations or warranties with respect to its contents or use, and specifically disclaims any expressed or implied warranties of merchantability or fitness for any particular purpose. To the maximum extent permitted by applicable law, in no event shall TeachUcomp, Inc. or its suppliers be liable for special, incidental, indirect, or consequential damages whatsoever (including, without limitation, damages for loss of business information, or any other pecuniary loss) arising out of the use of this product or contents, or the inability to use the software product, even if TeachUcomp, Inc. has been advised of the possibility of such damages. Because some states and jurisdictions do not allow the exclusion or limitation of liability for consequential or incidental damages, the limitation may not apply to you. TeachUcomp, Inc. reserves the right to make changes to this product at any time, without obligation to notify any person or entity of such changes.

No part of this product may be reproduced or transmitted in any form or by any means, electronic or mechanical, including photocopying, recording, or information storage and retrieval systems, for any purpose, without the express written consent of TeachUcomp, Inc.

TeachUcomp, Inc. is a registered trademark of TeachUcomp, Inc. All other registered trademarks are the property of their respective companies and do not imply any association with TeachUcomp, Inc. All rights reserved.

Copyright © TeachUcomp, Inc. All rights reserved. Printed in the United States of America. All rights reserved.

Trademark Acknowledgements:

Adobe Dreamweaver, Adobe Bridge, Adobe Photoshop, Adobe Photoshop Elements, Adobe Illustrator, Adobe ImageReady and Adobe Acrobat are registered trademarks of Adobe Systems Incorporated. Other brand names and product names are trademarks or registered trademarks of their respective holders.

Disclaimer:

While every precaution has been made in the production of this book, TeachUcomp, Inc. assumes no responsibility for errors or omissions. Nor is any liability assumed for damages resulting from the use of the information contained herein. These training materials are provided without any warranty whatsoever, including, but not limited to, the implied warranties of merchantability or fitness for a particular purpose. All names of persons or companies in this manual are fictional, unless otherwise noted.
Welcome to TeachUcomp Incorporated’s Advanced Dreamweaver course. This class is designed to take a user with little to no knowledge of Dreamweaver through the skills necessary to master the use of the Dreamweaver application. To that end, it is also an excellent tutorial for those users who are already familiar with Dreamweaver, but want to “fill-in” the gaps in their knowledge of the program.

Adobe Dreamweaver is an excellent program to learn, as the skill, terms, and techniques that we learn and master in this application can also be used throughout the rest of the Adobe applications. For example, after learning this application, you will find it easier to learn an application like Adobe Illustrator or Adobe Photoshop.

This class continues our work in creating websites by discussing tables and how to use them in site creation. We will then discuss Cascading Style Sheets and also explore how to insert and use spry and widgets. Once we have discovered how to create our sites, we’ll learn how to publish a site and discuss advanced website management techniques.

This advanced course finishes when a bonus chapter on Adobe’s Bridge application (used by many of Adobe’s programs such as Dreamweaver and Photoshop) to store and manage images and files.
# Table Of Contents

<table>
<thead>
<tr>
<th>Topic:</th>
<th>Page(s):</th>
<th>Topic:</th>
<th>Page(s):</th>
</tr>
</thead>
<tbody>
<tr>
<td>Introduction and Overview</td>
<td>3</td>
<td>Publishing Your Website</td>
<td>65</td>
</tr>
<tr>
<td>Table of Contents</td>
<td>4</td>
<td>Domain Names Versus Web Hosting</td>
<td>66</td>
</tr>
<tr>
<td>Table of Contents</td>
<td>5</td>
<td>When is my site ready to publish?</td>
<td>67</td>
</tr>
<tr>
<td>Tables</td>
<td>6</td>
<td>Setting Up a Remote Site</td>
<td>68</td>
</tr>
<tr>
<td>When to Use Tables</td>
<td>7</td>
<td>Connecting to a Remote Site</td>
<td>69</td>
</tr>
<tr>
<td>Creating Tables</td>
<td>8</td>
<td>Putting Files on the Remote Site</td>
<td>70</td>
</tr>
<tr>
<td>Inserting and Editing Content in Tables</td>
<td>9</td>
<td>Cancelling Uploads and Deleting Remote Site Files</td>
<td>71</td>
</tr>
<tr>
<td>Editing Rows and Columns</td>
<td>10</td>
<td>Downloading Files from the Remote Site</td>
<td>72</td>
</tr>
<tr>
<td>Table Borders and Backgrounds</td>
<td>11</td>
<td>Publishing Your Website- Actions</td>
<td>73-74</td>
</tr>
<tr>
<td>Spacing and Padding in Table Cells</td>
<td>12</td>
<td>Publishing Your Website- Exercises</td>
<td>75</td>
</tr>
<tr>
<td>Merging and Splitting Table Cells</td>
<td>13</td>
<td>Website Management</td>
<td>76</td>
</tr>
<tr>
<td>Tables- Actions</td>
<td>14</td>
<td>Site Assets</td>
<td>77</td>
</tr>
<tr>
<td>Tables- Exercises</td>
<td>15</td>
<td>Changing Links Site-Wide</td>
<td>78</td>
</tr>
<tr>
<td>CSS Basics</td>
<td>16</td>
<td>Finding and Replacing Text</td>
<td>79</td>
</tr>
<tr>
<td>Working with Cascading Style Sheets</td>
<td>17</td>
<td>Site Reports</td>
<td>80</td>
</tr>
<tr>
<td>Editing CSS Styles</td>
<td>18</td>
<td>Checking Files In and Out</td>
<td>81</td>
</tr>
<tr>
<td>Creating Class Styles</td>
<td>19</td>
<td>Using Design Notes</td>
<td>82</td>
</tr>
<tr>
<td>Applying Class Styles</td>
<td>20</td>
<td>Website Management- Actions</td>
<td>83</td>
</tr>
<tr>
<td>Editing CSS Styles</td>
<td>21</td>
<td>Website Management- Exercises</td>
<td>84</td>
</tr>
<tr>
<td>Customizing HTML Tags</td>
<td>22</td>
<td>Adobe Bridge</td>
<td>85</td>
</tr>
<tr>
<td>Modifying Fonts Using CSS</td>
<td>23</td>
<td>The Adobe Bridge Environment</td>
<td>86-88</td>
</tr>
<tr>
<td>CSS Basics- Actions</td>
<td>24-25</td>
<td>Display Options</td>
<td>89</td>
</tr>
<tr>
<td>CSS Basics- Exercises</td>
<td>26</td>
<td>Compact Mode</td>
<td>89</td>
</tr>
<tr>
<td>CSS Layouts and AP Divs</td>
<td>27</td>
<td>Navigating, Opening &amp; Placing Files</td>
<td>90</td>
</tr>
<tr>
<td>Creating External Style Sheets</td>
<td>28</td>
<td>Searching for Files and Folders</td>
<td>91</td>
</tr>
<tr>
<td>Attaching External Style Sheets</td>
<td>29</td>
<td>Labeling and Rating Files</td>
<td>92</td>
</tr>
<tr>
<td>Editing an External Style Sheet</td>
<td>30</td>
<td>Sorting and Filtering Files</td>
<td>93</td>
</tr>
<tr>
<td>Absolute Positioning Versus Relative Positioning</td>
<td>31</td>
<td>Copying, Moving and Deleting Files</td>
<td>94</td>
</tr>
<tr>
<td>About AP Divs</td>
<td>32</td>
<td>Stacking and Unstacking</td>
<td>94</td>
</tr>
<tr>
<td>Nested AP Divs</td>
<td>33</td>
<td>Previewing Images and the Loupe Tool</td>
<td>95</td>
</tr>
<tr>
<td>Designing a Web Page Using CSS Layouts</td>
<td>34</td>
<td>Rotating Images</td>
<td>95</td>
</tr>
<tr>
<td>Editing CSS Layouts</td>
<td>35</td>
<td>Viewing a Slideshow</td>
<td>95</td>
</tr>
<tr>
<td>Inserting an Image Into a Header</td>
<td>36</td>
<td>Viewing and Editing Metadata</td>
<td>95</td>
</tr>
<tr>
<td>Adding Images to a CSS Layout</td>
<td>37</td>
<td>Keywords</td>
<td>96</td>
</tr>
<tr>
<td>CSS Layouts and AP Divs- Actions</td>
<td>38-40</td>
<td>Adobe Bridge- Actions</td>
<td>97-100</td>
</tr>
<tr>
<td>CSS Layouts and AP Divs- Exercises</td>
<td>41-42</td>
<td>Adobe Bridge- Exercises</td>
<td>101</td>
</tr>
<tr>
<td>Spry Widgets &amp; Forms</td>
<td>43</td>
<td>Dreamweaver Keyboard Shortcuts</td>
<td>102-104</td>
</tr>
<tr>
<td>Spry Widgets, Behavior Events and Actions</td>
<td>44</td>
<td>Spry, Widgets &amp; Forms- Actions</td>
<td>57-61</td>
</tr>
<tr>
<td>Creating a Drop-Down Menu</td>
<td>45</td>
<td>Spry, Widgets &amp; Forms- Exercises</td>
<td>62-64</td>
</tr>
<tr>
<td>Editing a Drop-Down Menu</td>
<td>46</td>
<td>About Forms</td>
<td>51</td>
</tr>
<tr>
<td>Creating Tabbed Panels</td>
<td>47</td>
<td>Adding Text Fields to Forms</td>
<td>52</td>
</tr>
<tr>
<td>Adding Content to Tabbed Panels</td>
<td>48</td>
<td>Inserting Checkboxes Into Forms</td>
<td>53</td>
</tr>
<tr>
<td>Editing Tabbed Panels</td>
<td>49</td>
<td>Inserting Radio Buttons Into Forms</td>
<td>54</td>
</tr>
<tr>
<td>Open Browser Window Behavior</td>
<td>50</td>
<td>Inserting Lists and Menus Into Forms</td>
<td>55</td>
</tr>
<tr>
<td>About Forms</td>
<td>51</td>
<td>Adding Buttons to Forms</td>
<td>56</td>
</tr>
<tr>
<td>Adding Text Fields to Forms</td>
<td>52</td>
<td>Spry, Widgets &amp; Forms- Actions</td>
<td>57-61</td>
</tr>
<tr>
<td>Inserting Checkboxes Into Forms</td>
<td>53</td>
<td>Spry, Widgets &amp; Forms- Exercises</td>
<td>62-64</td>
</tr>
<tr>
<td>Inserting Radio Buttons Into Forms</td>
<td>54</td>
<td>Inserting Lists and Menus Into Forms</td>
<td>55</td>
</tr>
<tr>
<td>Inserting Lists and Menus Into Forms</td>
<td>55</td>
<td>Adding Buttons to Forms</td>
<td>56</td>
</tr>
</tbody>
</table>
CHAPTER 7 - Tables

7.1 - When to Use Tables

7.2 - Creating Tables

7.3 - Inserting and Editing Content in Tables

7.4 - Editing Rows and Columns

7.5 - Table Borders and Backgrounds

7.6 - Spacing and Padding in Table Cells

7.7 - Merging and Splitting Table Cells
7.1 – WHEN TO USE TABLES:

In this lesson, you will learn when it is appropriate to design your web page using Tables. Although table-based layouts used to be the best way to create complex web pages, many people now believe that designing a page using CSS is easier and more effective. Tables can be a bit difficult to understand and format and can appear radically different when viewed using different devices or web browsers. Websites designed using tables can also be somewhat tricky to maintain, as well. Even so, many websites on the Internet today still rely on tables to format their pages.

Using tables to design your web page is a good idea if you plan to include a lot of information that would naturally appear in a grid-format, on a spreadsheet, or on a chart. In the next lessons, you will learn the basics of creating and using tables in web pages.

7.2 – CREATING TABLES:

In this lesson, you will learn to insert a table into a web page. Start with a new, blank page. Make sure that the “Insert” panel is set to “Common” using the downward-pointing arrow at the top of the panel. Next, click the “Table” icon found in the “Insert” panel. This will open the “Table” dialog box. By clicking into the various text fields of this dialog box, you can set the basic parameters for your table. Let’s make a table with three columns and four rows. Click into the “Rows” text field and type “4.” Next, click into the “Columns” text field and type “3.” If there are already values in these boxes, use your backspace or delete to get rid of them before entering your own values.

Next, click into the “Table Width” text field, and enter 600. To the right of the “Table Width” text field, you’ll see a drop-down menu that lets you select between pixels and percent. This means that I can designate this table to be either 600 pixels wide, or I could designate that this table take up a certain percentage of the screen on the page. Choosing pixels allows you to be very specific about the size of a table, but keep in mind that some people may be viewing your page on a smaller device, and those viewers will have to scroll around to see all of the information on your page. For now, set this text field to “pixels,” so that your table width will be 600 pixels.

Next, let’s choose a border thickness. Click within the “Border thickness” text field, and enter “5.” For now, ignore Cell padding and spacing—those will be addressed in a future lesson. Next, let’s choose a “Header” setting. “Headers” are the boxes on your table that define what kind of information is found in the row or column of that header. Click the “Top” header, and then click “OK.” The dialog box will close, and you will see that your table has been inserted onto the page.

If you do not intend to learn all of the lessons in this chapter at one time, please save this page, as all of the lessons in this chapter will begin with this same table.
7.3 – INSERTING AND EDITING CONTENT IN TABLES:

In this lesson, you will learn how to add content to tables on a web page. Using the techniques from the previous lesson, insert a table into a blank page using the same specifications as before: Three columns, four rows, with a total table width of 600 pixels, and a border thickness of five pixels. Make sure to choose the “Top” Heading as in the previous lesson. This will create a table with twelve individual cells.

Next, use your mouse to click into the top left cell of the table. You can now insert text, images, or other content into this cell much as you would insert them into a regular web page. I’m going to type “Breakfast,” “Lunch” and “Dinner” into my three Header spots by clicking and typing in each cell. Then I can click and add the rest of my data in the appropriate cells. You’ll notice that the Header text is in bold, while the rest of the text is not. By clicking and highlighting text, I can format and align it within the cell just as I would format text on a normal web page. If I highlight “cereal” in the “Breakfast” column, for example, I can then choose “Align” from the “Format” drop-down menu found in the Menu Bar to center the word within the cell.

You should note that, if you insert an image that is too big for a cell, the cell will adjust to accommodate your image.

To edit content within a table, simply select the element you wish to edit by clicking on images or by clicking and dragging to highlight text, and then editing as you would edit images or text in a regular web page.
7.4 – EDITING ROWS AND COLUMNS:

In this lesson, you will learn to use Dreamweaver to edit the rows and columns of web page tables. Make sure that you have the same table open that we have been using in previous lessons.

First, let’s add a fourth column to the table. Move your mouse over the very outside of the table until you see a red outline, and then click. This will select the entire table, and you can use the Properties Inspector to examine and edit its various settings.

Click inside the “Columns” or “Cols” text field, and use your backspace or delete key to get rid of the number three, and then type in “4.” Then hit the “Enter” key on your keyboard. You will see that Dreamweaver adds another column to your table. Click inside of the new cells and type text.

To delete a column, move your mouse above the column until you see a black arrow pointing at the column along with a red outline around only the column. Click to select the column, then press the “Delete” key on your keyboard. This will remove the column. You can add and delete rows using this same method.

You can also use the Properties Inspector to manually change the width of each column. Click on the column to choose it, and then click within the “Width” text field in the Properties Inspector. Type in “200” and press the “Enter” key on your keyboard. You will see the column adjust accordingly. I can do this with the other two columns, to make sure that my 600 pixel-wide table has three columns of equal width. Keep in mind, though, that there are a few pixels used as “padding” between the cells, so that each cell might actually be a few pixels more narrow than I intended. If I click on the outside of the table to select it, Dreamweaver will display the pixel widths of the entire table as well as each column.
7.5 – TABLE BORDERS AND BACKGROUND:

In this lesson, you will learn how to adjust the borders and background colors of your table. Start with the same table that we’ve been using for the previous several lessons. Let’s add a background color to the headers of this table.

Move your mouse to the top left corner of the table until you have highlighted the top row of header cells. You will know when the row is highlighted because two things will happen: A black arrow will appear and point at the row of cells, and a thin red border will appear around the row. Once the row is highlighted, click to select it. The Properties Inspector will reflect your choice. Click the “Bg” background icon found in the Properties Inspector panel. This will open a color palette, and the mouse arrow changes into an eyedropper. Click on the palette to choose a color for your header background. The palette will close, and you will see the background color on your headers, as well as next to the background icon in the Properties Inspector. You will also notice that your color’s exact number, known as the “hexadecimal color code,” is also displayed in the Properties Inspector. This is useful information to have if you plan to use the same color on different web pages—you can make note of the code, and simply type it into the text field on subsequent pages in order to use it again.

By clicking and dragging, you can select some or all of the remaining cells in the table, and assign a background color to them, as well. Make sure that the color you choose is not too close to the color of your text, or viewers may have a problem viewing your table contents.

To adjust the border of a table, first move your mouse around one of the outside corners of the table until the entire table has a thin red border around it. When you see the red border, click to select the table.

Now, click into the “Border” text field in the Properties Inspector panel, and use your backspace or delete key to get rid of the 5, and type in “10” instead. Hit “Enter.” You will notice that the border width doubles to accommodate your adjustment.

Some website designers use tables with no visible border in order to get a cleaner looking page. To do this, simply set the Border value to zero.
7.6 – SPACING AND PADDING IN TABLE CELLS:

In this lesson, you will learn how to change the amount of spacing between the cells in a table, as well as how to change the amount of space between a cell’s content and its border. Make sure that you start with the same table that we’ve been using for the previous several lessons.

Let’s add more space between the cells of this table. First, move your mouse around a corner of the table until you see a thin red line surround the entire table. Click to select the table.

Next, click into the “CellSpace” text field in the Properties Inspector panel and type “5,” and then hit “Enter” on your keyboard. You will see that Dreamweaver adds five pixels of space between the cells of this table.

To add padding between the area of content and the edge of your table cells, click into the “CellPad” text field in the Properties Inspector, and type “5.” Now hit “Enter” on your keyboard. You will notice that your cells become slightly larger. This is because Dreamweaver has added five pixels of “padding” to each cell. That means that the content of each cell in your table will have five pixels of space between it and the outside of the cell. You cannot add padding to individual cells—your “CellPad” value will affect every cell in the table.

It’s a good idea to format the spacing and padding of your table after you add all of your content to the table. That way, you will have some idea about how much space is really necessary between the elements of your table.
7.7 – MERGING AND SPLITTING TABLE CELLS:

In this lesson, you will learn how to merge and split table cells using Dreamweaver. Begin with the same table that you have been using for the previous several lessons.

Let’s merge two table cells together. This just means that we are going to combine two cells so that they become one. First, use your mouse to click and drag to select two cells that you want to merge. You will know which cells you have selected, because they will have a thicker border than the rest of the cells in the table. Next, click the “Merge” icon found near the bottom-left corner of the Properties Inspector panel. You will see that Dreamweaver combines the two cells into one cell.

Now, let’s split a cell. This just means that we are going to divide an existing cell from this table into two separate cells. Click to place the blinking cursor inside of the cell you want to split. Next, click the “Split cell” icon found just to the right of the “Merge” icon in the Properties Inspector. This will open the “Split cell” dialog box. Using the dialog box, click the “Columns” radio button, and make sure the value is set to “2.” Then click “OK.” The dialog box will close, and the cell has now been split into two equal columns.

Merging and splitting cells can be an effective way to achieve impressive page layouts, especially if you intend to use invisible borders. Although it isn’t possible to merge complex shapes of cells together, Dreamweaver will allow you to merge as many cells together as you like, provided that they all are in the same column or row, and are all connected.
CREATING A TABLE:
1. Set the “Insert” panel to “Common.”
2. Click within the document at the spot where you want to add a table.
3. Click the “Table” icon found in the “Insert” panel.
4. Set parameters for your table within the “Table” dialog box.
5. Click “OK.”

ADDING CONTENT TO A TABLE:
1. Click within a table cell.
2. Use the “Insert” panel to insert content into the cell.

EDITING ROWS AND COLUMNS:
1. Move your cursor over the outside of a table until you see a red outline, and then click to select the entire table.
2. Use the Properties Inspector to edit your table.

ADJUSTING TABLE BORDERS:
1. Move your cursor over the outside of a table until you see a red outline, and then click to select the entire table.
2. Type a new value into the “Border” text field in the Properties Inspector.
ADJUSTING TABLE BACKGROUND COLORS:
1. Select the cells, rows or columns that will receive a new background color.
2. Click on the “Bg” background icon in the Properties Inspector.
3. Use the color cubes palette to choose a new background color.

ADDING SPACE AND PADDING TO TABLE CELLS:
1. Move your cursor over the outside of a table until you see a red outline, and then click to select the entire table.
2. To add space between the cells, type a pixel value into the “CellSpace” text field in the Properties Inspector.
3. To add padding within the cells, type a pixel value into the “CellPad” text field in the Properties Inspector.

MERGING TWO TABLE CELLS INTO ONE:
1. Click-and-drag to select the two cells that will merge.
2. Click the “Merge” icon found in the Properties Inspector.

SPLITTING A TABLE CELL INTO TWO CELLS:
1. Click to select a table cell.
2. Click the “Split Cell” icon in the Properties Inspector.
EXERCISES—
Tables

Purpose:
1. To be able to create and manipulate tables within a web page.

Exercises:

1. Open your Dreamweaver application.
2. Ensure that you have the “Dreamweaver Test Site” open.
4. Select “Blank Page” from the “Category:” list at the left side of this dialog box.
5. Select “HTML” in the “Page Type:” list in the middle of the dialog box.
6. Click the “Create” button in the lower right corner of the “New Document” dialog box.
7. Select “File | Save As...” from the Menu Bar.
8. Ensure that you have the “root” folder selected in the “Save in:” drop-down.
9. Type “tables” into the “File name:” text box.
10. Click the “Save” button in the lower right corner of the “Save As” dialog box.
11. Click into the “tables.html” document.
12. Select “Insert | Table” from the Menu Bar.
13. Type “1” into the “Rows:” text box.
14. Type “2” into the “Columns:” text box.
15. Type “400” into the “Table Width:” text box and then select “pixels” from the drop-down to the right.
16. Type “0” into the “Border thickness:” text box.
17. Type “0” into the “Cell padding:” text box.
18. Type “0” into the “Cell spacing:” text box.
19. Click “OK” to insert the table into the web page.
20. Click into the right cell of the two cells within the table.
21. Select “Align Center” from the “Horz” drop-down in the “Properties” panel.
22. Select “Insert | Table” from the Menu Bar.
23. Type “5” into the “Rows:” text box.
24. Type “2” into the “Columns:” text box.
25. Type “200” into the “Table width:” text box and then select “pixels” from the drop-down to the right.
26. Click “OK” to insert the nested table.
27. Select the nested table which you just created.
28. Click into the upper left cell of the nested table and enter the following table information:

<table>
<thead>
<tr>
<th>Name</th>
<th>Department</th>
</tr>
</thead>
<tbody>
<tr>
<td>Bob Smith</td>
<td>Marketing</td>
</tr>
<tr>
<td>Jim Jones</td>
<td>Marketing</td>
</tr>
<tr>
<td>Sandy Jones</td>
<td>Technician</td>
</tr>
<tr>
<td>Kim White</td>
<td>Administration</td>
</tr>
</tbody>
</table>

(cont.)
29. Click into the left cell of the original table which you inserted into the web page.
30. Type “Employee Roster:” into the cell.
31. Check the “No wrap” checkbox in the “Properties” panel.
32. Select “Center” from the “Horz” drop-down in the “Properties” panel.
33. Select the “Employee Roster:” text within the cell.
34. Click the “B” button in the “Properties” panel to apply bolding to the selected text.
35. Select “Modify| Table| Insert Rows or Columns...” from the Menu Bar.
36. In the “Insert Rows or Columns” dialog box, select the “Rows” option in the “Insert:” section.
37. Type “1” into the “Number of rows:” text box.
38. Choose the “Below the Selection” option in the “Where:” section.
39. Click “OK” to insert the new row at the bottom of the table.
40. Select the cells in the new row which you just inserted.
41. Choose “Modify| Table| Merge Cells” from the Menu Bar.
42. Click into the new cell which you have created.
43. Select “Modify| Table| Delete Row” from the Menu Bar to delete the row which you just inserted.
44. Select “File| Save” from the Menu Bar to save the changes which you have made.
45. Select “File| Close” from the Menu Bar to close the web page.
46. Select “File| Exit” from the Menu Bar to exit the application.
8.1 - Working With Cascading Style Sheets (CSS)

8.2 - Editing CSS Styles

8.3 - Creating Class Styles

8.4 - Applying Class Styles

8.5 - Editing CSS Styles

8.6 - Customizing HTML Tags

8.7 - Modifying Fonts Using CSS
8.1 – WORKING WITH CASCADING STYLE SHEETS:

In this lesson you will learn the basics of CSS (which is short for “Cascading Style Sheets.”) You can use CSS in Dreamweaver to create complex and appealing web pages. Please note that it is not necessary to understand the theory behind CSS in order to use Dreamweaver effectively. CSS provide a versatile, precise and efficient means of controlling the appearance of content on your web page. With CSS, you can create web page designs that will appear as you intend on both large and small computer screens. CSS is also helpful when creating styles to align and position elements on your web page.

CSS works by applying instructions to the content of the web page. You can select either default CSS instructions provided by Dreamweaver or you can create custom instructions. These instructions can apply to just the content of one element on a page or to all of the pages on your website. When using traditional web page design, it is necessary to repeat the instructions for each page over and over again. CSS, however, is versatile enough to permit site-wide changes to a page element, like a heading, for example. These changes will apply to multiple pages and not just the one on which you are currently working.

In Dreamweaver there are four different style selector types: (1) the tag selector, which redefines existing HTML tags; (2) the class selector, which creates new styles that will apply to any chosen element on a web page, (3) the ID selector, which creates styles that are used to change an element once per page, and (4) the Compound selector, which combines two or more style definitions for maximum control of your page’s content and appearance.
8.2 – Editing CSS Styles:

In this lesson you will learn how to edit CSS Styles. It is easy to edit CSS styles in Dreamweaver using the CSS button in the Properties Inspector. First, click an element on the page that you want to format. Now click on the “CSS” button below the “HTML” button on the left side of the Properties Inspector. You will see that the CSS options now appear in the Properties Inspector.

Click the “Edit Rule” button in the Properties Inspector and the “CSS Rule Definition” dialog box will open. Click on “Type” from the “Category” menu and then click the downward-pointing triangle next to the “Font-family” text field. Choose a different font collection. Next, click on the “Color” square to open the color cubes menu and choose a new font color with the dropper. When you have made your selections click “OK.”

Now, click in the “CSS styles” panel on the “Rule” you have just modified. You will see that the Style Rule appears as recently modified and its properties are displayed in the “Properties” tab below. In this example, the font type and color for the “paragraph” text have been changed to Arial and green.
8.3 – CREATING CLASS STYLES:

In this lesson you will learn how to create Class Styles. “Class Styles” are used to format text and other elements on your web page without affecting HTML tags. You can then apply those styles to elements of your page just like you could with HTML tags.

To create a Class Style first click on “CSS Styles” from the “Format” drop-down menu found in the Menu Bar. Next, choose “New” from the menu bar which appears. This will open the “New CSS Rule” dialog box.

Click on the small black triangle in the first drop-down menu and select “Class”. Type a name for your new heading class style without spaces, special characters or any additional punctuation. We will call this Class Style “specialheading.” All class style names must begin with a period and Dreamweaver will add one for you automatically.

Choose “This Document Only” from the “Rule Definition” drop-down menu. Click “OK.” This will open the “CSS Rule Definition” dialog box. Select a Style category from the left side and change the style settings you desire. Let’s modify the font type, size and color. Click “OK.”

Next, click on the CSS Styles panel. The CSS Styles panel will display the new “specialheading” class style you have created. You can now apply the class style to the appropriate headings on your web page using the Properties Inspector. We will see how to do this in the next lesson.

Class styles are ideally used to quickly format content, such as headings and captions that may appear multiple times throughout the same web page.
8.4 – APPLYING CLASS STYLES:

In this quick lesson you will learn how to apply class styles to elements on your web page. We are going to apply the “specialheading” style that we created in the previous lesson. For this lesson we have selected the “3 Columns Fixed” option after choosing a New Blank Document from the “File” menu in the Menu Bar.

To apply the “specialheading” Class Style, first click and drag to highlight the heading text. Next, click the “HTML” button on the left side of the Properties Inspector. Click the small black triangle on the “Class” drop-down menu. Choose the name of the heading style you recently created and Dreamweaver applies that style to the highlighted text. You can apply this style to multiple headings on your web page.

To apply a class style to an image on your page, first click on the image to select it. In the Properties Inspector click the small black triangle on the “Class” drop-down menu and then click on the style you wish to apply to the image. For this example, I am choosing the class style “Float Left” which is abbreviated to “fltlft”.

You can see that applying this class style results in left alignment of my image, as well as margin spacing of 8 pixels on the right side to keep the text from crowding my image.
8.5 – EDITING CSS STYLES:

In this lesson you will learn how to edit CSS styles. Once you have edited a style, it is simple to automatically apply the same style changes to text or images on your web page. Let’s change the color of the “specialheading” Class Style in this example. In the “CSS Styles” panel click the “+” icon to show all of the styles. Next, double-click on the style you wish to edit, in this case the “specialheading” style. The “CSS Rule Definition” dialog box will appear.

Click on the “Color Picker” to access the color cubes menu. Choose a new color for the “specialheading” and click “OK.”

Your style sheet changes will be saved and Dreamweaver will automatically apply them wherever that style has been used. Your “specialheading” throughout the web page will now appear in the new color.
8.6 – CUSTOMIZING HTML TAGS:

In this lesson, you will learn how to customize HTML tags. Using Dreamweaver you can quickly and easily customize an existing HTML tag and modify its appearance. Customizing HTML tags allows you to make several changes to tags at once which would otherwise require two or more steps.

For example, your new HTML tag for Heading 2 could include updated color and font selections in one easy step. Additionally, if a visitor’s browser does not support style sheets the HTML tag will apply the appropriate formatting so their browser will display your content as you intended it to appear.

Let’s customize the “Heading 2” tag. Start by opening a page which includes text and headings. Click on the “HTML” button in the Properties Inspector. Select each heading by clicking and dragging the text. Format each heading with the “Heading 2” tag from the “Format” drop-down menu in the Properties Inspector.

Next, choose “CSS Styles” from the “Format” drop-down menu found in the Menu Bar. Then, choose “New” from the side menu which appears. This will open the “CSS Rule” dialog box. Click the downward-pointing arrow to the right of the text field under “Selector Type” and click “Tag”.

Next, click the downward-pointing triangle to the right of the “Selector Name” text field and choose the HTML tag you wish to modify. In this example we are modifying the “h2” tag. Leave the “Rule Definition” selection as “This document only” and click “OK”. The “CSS Rule Definition” dialog box opens.

Click on “Type” from the “Category” menu on the left side. Then click the downward-pointing triangle for the “Font-family” text field and choose a new font collection for the “h2” tag. Next, click on the “Color” square and choose a new color for the “h2” tag. Now click “OK”.

The headings on your page are now updated with the changes you have made to the “h2” tag and those changes are shown in the “Properties” area below the “CSS Styles” panel.
8.7 – MODIFYING FONTS USING CSS:

In this lesson you will learn how to modify font types using Cascading Style Sheets. Make sure you have a document open that contains some text.

Dreamweaver provides a CSS mode within the Properties Inspector to enable easy changes to style rules for text and other elements. To change the typeface—or “font”—in Dreamweaver you must use CSS. To change the font, first click-and-drag to select the text you want to change, and then click the “CSS” button within the Properties Inspector. In this example we will be changing the font of the paragraph text. Next, click the downward-pointing triangle to the right of the “Font” text field, and select a font collection. The “CSS Rule” dialog box opens. If you would like to you can name this new style in the “Selector Name” text field. Be sure to avoid spaces or special characters when naming a new style.

Click on the downward-pointing triangle of the “Selector Type” drop-down menu and choose “Tag.” If the text you selected is governed by an existing HTML tag, Dreamweaver will show the tag name in the Selector Name text field. In this example the text we have selected is governed by the “paragraph” HTML tag and this is indicated by a small letter ‘p.’ Click “OK.” The paragraph text in the document will change to your new font selection. This new style can be applied to other elements by using the Properties Inspector. If you go to the CSS Styles panel and click on the small “p” you will see the current font selection in the “Properties” area directly below. Click on the font collection name. A drop-down menu triangle will appear on the right and you can select a different font for the paragraph style if you like.

Remember, Dreamweaver groups fonts in threes to give you as much design control as is possible when you don’t know which fonts will be available on the device used to display your web page. For a more complete explanation of why Dreamweaver offers font choices in groups of three, review the “Working with Fonts” lesson from Chapter Three.
EDITING A CSS STYLE:
1. Click the “CSS” button on the left side of the Properties Inspector.
2. Click the “Edit Rule” button in the Properties Inspector to open the “CSS Rule Definition” dialog box.
3. Choose “Type” from the Category menu.
4. Edit your style using the dialog box.
5. Click “OK” to confirm your choices.

CREATING A CLASS STYLE:
1. Choose “CSS Styles” from the “Format” drop-down menu in the Menu Bar.
2. Choose “New” from the menu bar which appears. This will open the “New CSS Rule” dialog box.
3. Click the small black triangle in the first drop-down menu, and select “Class.”
4. Type a one-word name for your new class style.
5. Choose “This Document Only” from the “Rule Definition” drop-down menu.
6. Click “OK.” This will open the “CSS Rule Definition” dialog box.
7. Select a style category from the left side of the dialog box.
8. Change the style settings as you desire.
9. Click “OK” to confirm your choices.

APPLYING A CLASS STYLE:
1. Click-and-drag to select the text that will have a class style applied.
2. Click the “HTML” button on the left side of the Properties Inspector.
3. Click the small black triangle on the “Class” drop-down menu.
4. Click to select the style that you want to apply.
EDITING A CLASS STYLE:
1. Open the “CSS Styles” panel by checking “CSS Styles” in the “Window” drop-down menu in the Menu Bar.
2. Click the “+” icon in the “CSS Styles” panel to display all of the available styles.
3. Double-click on the style you wish to edit. This will open the “CSS Rule Definition” dialog box.
4. Edit your style using the dialog box.
5. Click “OK” to confirm your choices.

MODIFYING FONTS USING CSS:
1. Click-and-drag to select the text you want to modify.
2. Click the “CSS” button on the left side of the Properties Inspector.
3. Click the downward-pointing triangle to the right of the “Font” text field in the Properties Inspector.
4. Select a font collection. The “CSS Rule” dialog box will open.
5. Name the new style in the “Selector Name” text field.
6. Click on the downward-pointing triangle next to the “Selector Type drop-down menu, and choose “Tag.”
7. Click “OK.”
EXERCISES - CSS BASICS

Purpose:
1. There are no exercises for this chapter.

Exercises:
1. None.
CHAPTER 9-
CSS Layouts and AP Divs

9.1 - Creating External Style Sheets
9.2 - Attaching External Style Sheets
9.3 - Editing an External Style Sheet
9.4 - Absolute Positioning Versus Relative Positioning
9.5 - About AP Divs
9.6 - Nested AP Divs
9.7 - Designing a Web Page Using CSS Layouts
9.8 - Editing CSS Layouts
9.9 - Inserting an Image into a Header
9.10 - Adding Images to a CSS Layout
9.1 – CREATING EXTERNAL STYLE SHEETS:

In this lesson you will learn how to create External Style Sheets. When you attach an External Style Sheet to a number of web pages on your site, you can make changes to all of the pages at once by simply changing the External Style Sheet. When you use External Style Sheets, you can save preferences for how certain elements will appear on your web pages. In this way, it is easy to maintain control of the appearance of many web pages. When you use External Style Sheets, you will not have to make lots of separate and time-consuming design changes to web pages one by one.

To create an External Style Sheet, first choose “New” from the “File” drop-down menu found in the Menu Bar. This will open the “New Document” dialog box. Next, choose “Blank Page” from the “Page Type” menu and then choose “CSS.” Now click “Create”. A new blank CSS file will appear, and you can edit it however you like.

To save a style sheet, first choose “Save” from the “File” drop-down menu found in the Menu Bar. This will open the “Save As” dialog box. Type in a name for the External Style Sheet, I’m going to call this one “Style1” and then click “Save.” The External Style Sheet will be created inside of your local site folder.

You will notice that your new style sheet now appears in the CSS Styles panel, as well as in the Files panel.
In this lesson, you will learn how to attach an External Style Sheet to one or more web pages on your site. This is helpful if you want to make your web pages uniform in appearance without having to adjust each page individually. Multiple style sheets can be attached to a single web page, allowing you to use style rules from any of the attached style sheets to modify elements of your web pages.

Let’s attach an External Style Sheet to a web page. First, open the web page that you want to attach to a style sheet. Next, choose “CSS Styles” from the “Format” drop-down menu found in the Menu Bar. Choose “Attach Style Sheet” from the side menu which appears. This will open the “Attach External Style Sheet” dialog box. Click the “Browse” button to open the “Select External Style Sheet File” dialog box. Now, locate the appropriate style sheet to attach by navigating within the “Look In” drop-down menu. You can tell which files are Style Sheets because these files end with “.css.” Find one that you want to use, and then click “OK.” The “Select Style Sheet File” dialog box will close, leaving the “Attach External Style Sheet” dialog box open. Click “OK” to confirm your selections.

Dreamweaver will attach the External Style Sheet to your web page, and the style sheet is displayed in the CSS Styles panel. Any styles from that External Style Sheet will be applied to the attached web page.
9.3 – EDITING AN EXTERNAL STYLE SHEET:

In this lesson, you will learn how to edit an External Style Sheet. To change the appearance of styles in an External Style Sheet, first double-click on the style you want to change in the CSS Styles panel. The “CSS Rule Definition” dialog box will open, and you can now choose a style category to make necessary changes. Let’s change the font color on this External Style Sheet. First, click on the “Color” square to access the color cubes menu and make a new color selection. Now click “OK” to confirm your choice and apply the change.

Dreamweaver will save the new style definition in the External Style Sheet. The changes will automatically be applied to any web page that is attached to the External Style Sheet. This is how you can update many pages at once—simply modify the External Style Sheet to which your pages are attached, rather than changing the pages one at a time.
9.4 – ABSOLUTE POSITIONING VERSUS RELATIVE POSITIONING:

In this lesson, you will learn about the differences between absolute positioning and relative positioning of elements on a web page. Before you can decide which positioning will work best for your page, you will have to learn a little bit about the theory of each.

When you insert an element, like an image, into a web page, you have to decide how the element will be displayed on the Internet when someone views your page. If you do not assign any positioning to your element, it is known as a static element. This means that the element will be displayed using the default settings of the browser or device used to view your page. Once you assign positioning rules for an element – for example, if I align this image to the right – the image ceases to be a static element, because a positioning rule has been applied to it.

The next step is to understand the difference between relative and absolute positioning. Let’s discuss relative positioning first. The example I just gave, where I aligned the image to the right of the page, is an example of relative positioning. This means that the image will be to the right of the page relative to the rest of the elements on the page, regardless of what type or size browser window is being used to display the page.

With absolute positioning, on the other hand, you are giving very specific rules to the web browser concerning the display of your element. Instead of telling the browser to put the image on the right of the display, absolute positioning tells the browser exactly where on the page you want your image displayed. Also, it’s important to note that, if you use absolute positioning to set the rules about how your image will be displayed, the browser will display your image without considering any of the other elements on the page.

The problem with absolute positioning is that, although you are able to set very specific rules about how you want your element displayed, different browsers will respond to absolute positioning differently. Consequently, your web page might be displayed in such a way that certain elements overlap each other or aren’t visible at all, depending on the viewer’s device and software settings.
9.5 – ABOUT AP DIVS:

In this lesson, you will learn how to create AP Divs. AP Divs, known as “layers” in previous editions of Dreamweaver, are blocks of content that you can absolutely position on a web page. AP Divs function independently from other content on your page, and they can be stacked on top of each other, and even nested within each other. Let’s create an AP Div. Start with a new, blank page, and click the downward-pointing arrow found to the right of the word “Common” in the “Insert” panel. This will open a drop-down menu, click on the word “Layout.” The menu will close, and you will see that the contents of the “Insert” panel have changed to reflect your choice.

Next, click the “Draw AP Div” icon in the “Insert” panel. Then click and drag within the document window to define the AP Div on the page. When you let go of the mouse button, a blue outline will appear around the AP Div. You can grab the AP Div by the outline and move it around on the page, or click and drag the boxes on the blue outline to adjust the shape and size of the AP Div. Notice that the Properties Inspector panel displays properties of the AP Div when it is selected. You can also edit the AP Div within the Properties Inspector.

To add content to an AP Div, simply click the downward-facing arrow found to the right of the word “Layout” in the “Insert” panel, and choose “Common.” This will make the “Insert” panel revert to the settings that you have been using in previous lessons. Click inside of the AP Div and use the insert panel to insert an image into the AP Div.

When the image is selected, the Properties Inspector displays information about the image, as you would expect. If you click outside of the image within the AP Div border, the Properties Inspector displays information about the AP Div.

Please note that there is also an “AP Elements” panel. If you do not see it on your workspace, simply click on the “Window” drop-down menu in the Menu Bar and make sure that “AP Elements” is checked. The “AP Elements” panel will provide additional information that can be quite helpful, especially if you plan to use more than one AP Div on the same page.
9.6 – NESTED AP DIVS:

In this lesson, you will learn how to nest an AP Div within another AP Div. A “nested AP Div” is also sometimes referred to as a “child AP Div.” Start with a new, blank page, and use the techniques from the previous lesson to draw an AP Div on the page. Next, type or paste some text into the AP Div. I’m going to paste in some random text. Highlight the text and use the “Page Properties” button in the Properties Inspector to format your text just as you would on a normal page.

Next, click the downward-pointing arrow found to the right of the word “Common” in the “Insert” panel. This will open a drop-down menu, click on the word “Layout.” The “Insert” panel will change. Click on the “Draw AP Div” icon in the “Insert” panel, and then click and drag to draw another AP Div within the original AP Div, and under your text. You will notice that the Properties Inspector displays information about your nested AP Div, and the “AP Elements” panel also reflects your new AP Div, which appears as “apDiv2” in the “AP Elements” panel.

Click on the name “apDiv2” in the “AP Elements” panel. Notice how the Properties Inspector changes to reflect your selection. If you click on the name “apDiv1,” the Properties Inspector will display information about your parent AP Div. Clicking on the name of the AP Div within the “AP Elements” panel also selects that AP Div as the active element of the page. When the AP Div is selected, you can edit it and insert content into it just as you would a normal web page, regardless of its place in the “stacking order” of AP Divs.
9.7 – DESIGNING A WEB PAGE USING CSS LAYOUTS:

In this lesson you will learn to design a web page using CSS layouts. Before you start designing our own CSS layouts, let’s take a look at the predefined CSS layouts included with Dreamweaver.

Choose “New” from the “File” drop-down menu found in the Menu Bar. This will open the “New Document” dialog box. Next, choose “Blank Page” and then under “Page Type” choose “HTML.” Now, from the “Layout” menu, you can choose a predefined layout. I’m going to choose “1 column centered, liquid, header and footer.” Now click “Create.”

The dialog box will close, and Dreamweaver creates a page using the layout you just selected. From here, you can customize this page using the techniques from previous lessons.
9.8 – EDITING CSS LAYOUTS:

In this lesson, you will learn how to edit CSS layouts. Let’s change the background color of this web page’s footer area. First, using the CSS Styles panel, double-click on the particular style you want to edit. To change the footer, select the style that ends with “.footer.” When you double-click on the style name, the “CSS Rule Definition” dialog box opens.

To change the background color of the footer area, first click on “Background” under the “Category” menu. Next, click on the square “Background color” icon. Now choose a new background color and click “OK.” You will notice that the style has been updated in the CSS Styles panel, and that the new color appears at the bottom of the panel in the “Properties” area of the CSS Styles panel.

You can also make edits to CSS Styles from this panel by clicking on the Style’s appropriate property. If the property that you want to edit is not immediately visible, click “Add Property” to select from a full list of style properties.

You can find out which particular style is controlling the appearance of the various elements on your web page by first moving your mouse cursor to an element of your web page. I’m going to move my cursor to the Header Image area of the web page. When I click on this area and look in the “tag selector” area at the bottom of the document window, I can see that both the “Header” and “Image” tags are displayed. If I click within “Boulder Opal” and look in the “Targeted Rule” text field I can see that the “h1” tag controls the appearance of this element. Specifically the “.container .content h1” style rule is responsible for the appearance of this element.
9.9 – INSERTING AN IMAGE INTO A HEADER:

In this lesson, you will learn how to add an image to a layout Header. All of the CSS layouts included with Dreamweaver provide a Header area, into which you can add custom text or an image. Start by opening a new CSS Layout page.

If you want to replace the default text within the Header, simply click-and-drag to highlight the existing text, and type in your own text.

If you would like to add an image to a Header, follow these steps: First, double-click on the left side of the Header area to select the initial image provided by Dreamweaver. This will open the “Select Image Source” dialog box. Click on the downward-pointing arrow to the right of the “Look in” text field, and select the file folder containing your image. Next, click on the image to be inserted, and then click “OK.” If the “Image Tag Accessibility Attributes” dialog box appears, type in a description of your image and then click “OK.”

You will see your image in the page’s Header. To name this image, first click to select the image, and then click within the “Alt” text field of the Properties Inspector. You can now type in the new name for this image.
9.10 – ADDING IMAGES TO A CSS LAYOUT:

In this quick lesson, you will learn how to add an image to a CSS layout. Start by opening a new CSS layout in Dreamweaver.

Let’s add an image to this layout. First, click to place the blinking cursor at the spot in the layout where you want your image. Next, click the “Image” icon found in the Insert panel. This will open the “Select Image Source” dialog box. Click on the “Look in” drop-down menu and select the folder containing the image to be inserted. Now click to highlight the image and then click “OK.”

The “Image Tag Accessibility” dialog box will open, and you can type a description of your image. Now click “OK,” and the image will appear in your layout.
CREATING AN EXTERNAL STYLE SHEET:
1. Choose “New” from the “File” drop-down menu in the Menu Bar.
2. Choose “Blank Page” from the “Page Type” menu.
3. Choose “CSS”
4. Click “Create.”
5. Edit your new CSS file however you like.
6. Save your new style sheet to your root folder.
7. Your new style appears in the “CSS Styles” panel and the “Files” panel.

ATTACHING AN EXTERNAL STYLE SHEET:
1. Open a web page that you want to attach to an External Style Sheet.
2. Choose “CSS Styles” from the “Format” menu in the Menu Bar.
3. Choose “Attach Style Sheet” from the side menu. This will open the “Attach External Style Sheet” dialog box.
4. Navigate using the “Look In” drop-down menu to locate the appropriate style sheet.
5. Click “OK.”
6. Click “OK” again.

EDITING AN EXTERNAL STYLE SHEET:
1. Using the “CSS Styles” panel, double-click on the style you want to edit. This will open the “CSS Rule Definition” dialog box.
2. Choose a style category, and make necessary changes.
3. Click “OK” to apply your changes.
4. Changes will automatically be applied to any web page attached to the External Style Sheet.
CREATING AN AP DIV:
1. Set the “Insert” panel to “Layout.”
2. Click the “Draw AP Div” icon in the Insert Panel.
3. Click-and-drag within the document window to define the AP Div.

ADDING CONTENT TO AN AP DIV:
1. Set the “Insert” panel to “Common.”
2. Click within the AP Div.
3. Use the “Insert” panel to add content to the AP Div.

ADDING A NESTED AP DIV:
1. Open a web page that contains an AP Div.
2. Set the “Insert” panel to “Layout.”
3. Click the “Draw AP Div” icon in the “Insert” panel.
4. Click-and-drag within the original AP Div to define the boundaries of the nested AP Div.

DESIGN A PAGE USING CSS LAYOUTS:
1. Choose “New” from the “File” drop-down menu in the Menu Bar.
2. Choose “Blank Page.”
3. Under “Page Type,” choose “HTML.”
4. Choose a predefined layout.
5. Click “Create.”
EDITING A CSS LAYOUT:
1. Using the “CSS Styles” panel, double-click on the style you want to edit. This will open the “CSS Rule Definition” dialog box.
2. Choose a category from the menu on the left of the dialog box.
3. Make changes using the right side of the dialog box.
4. Click “OK” to confirm your changes.

INSERTING AN IMAGE INTO A HEADER:
1. Open one of Dreamweaver’s CSS layouts.
2. Double-click on the left side of the header area to select the default image provided by Dreamweaver. This will open the “Select Image Source” dialog box.
3. Navigate using the “Look In” drop-down field to locate the image.
4. Click to select the image.
5. Click “OK.”
6. If the “Image Tag Accessibility Attributes” dialog box opens, type a short description of the image and then click “OK.”

ADDING AN IMAGE TO A CSS LAYOUT:
1. Open one of Dreamweaver’s CSS layouts.
2. Click to place the blinking cursor at the spot in the page where you want to add an image.
3. Set the “Insert” panel to “Common.”
4. Click the “Image” icon in the “Insert” panel.
5. Using the “Select Image Source” dialog box, navigate to locate your image.
6. Click to select the image.
7. Click “OK.”
8. If the “Image Tag Accessibility Attributes” dialog box opens, type a short description of the image and then click “OK.”
EXERCISES-
CSS Layouts and AP Dvs

Purpose:
1. To be able to create and apply CSS styles in your web pages.

Exercises:
1. Open your Dreamweaver application.
2. Ensure that you have the “Advanced Test Site” opened in Dreamweaver.
3. Double-click the “linkedpage.htm” file in the “Files” panel that we created earlier to open it.
5. Type “.mystyle1” into the “Name:” text box in the “New CSS Rule” dialog box.
6. Ensure that “Class” is selected in the “Selector Type:” drop-down.
7. In the “Rule Definition:” section, select the “New Style Sheet File” option.
8. Click the “OK” button to launch the “Save Style Sheet File As” dialog box.
9. Click the “Create New Folder” button in the toolbar at the top of the “Save Style Sheet File As” dialog box, and then type “stylesheets” as the name of the folder. Press “Enter” on your keyboard to set the new folder name.
10. Double-click the new “stylesheets” folder to open it. It should show in the “Save in:” drop-down.
11. Click into the “File name:” text box and type “mystyles”.
12. Click the “Save” button to save the CSS file and display the “CSS Rule Definition” dialog box.
13. Ensure that the “Type” category is selected in the “Category” list at the left side of this dialog box.
14. Use the “Font:” drop-down to select the “Arial, Helvetica, sans-serif” font list.
15. Use the “Size:” drop-down to select “12.”
16. Use the drop-down to the right of that to select “points.”
17. Click into the “Color:” text box and type “#006666” as the color to use for text in the CSS style.
18. Click “OK” at the bottom of the “CSS Rule Definition” dialog box.
19. Select “File| Save All” from the Menu Bar to save your changes thus far.
20. Select the text displayed in the “linkedpage.htm” file.
21. Click the “HTML” button a the left end of the Properties Inspector.
22. Use the “Class” drop-down and select “.mystyle1.”
23. Select “Window| CSS Styles” from the Menu Bar to open the “CSS” panel.
24. Click the “+” sign to the left of “mystyles.css” and click on the name below it that appears.
25. Under “Properties” change the point size to 14.
26. Select “File| Save All” from the Menu Bar to save your changes.
27. Double-click on the “main.htm” file in the “Files” panel to open that file for editing in Dreamweaver.
28. Type “Welcome to my home page” into the file.
29. Select “Form| CSS Styles| Attach Style Sheet” from the Menu Bar.
30. Select “stylesheets/mystyles.css” from the drop-down.
31. Click “OK.”
32. Select the text that you just typed into the “main.htm” web page.
33. Select “Text| CSS Styles| mystyle1” from the Menu Bar to apply the style which you have defined.
34. Select “File| Save” from the Menu Bar.

(cont.)
EXERCISES - CSS LAYOUTS AND AP DIVS

Purpose:
1. To be able to create and apply CSS styles in your web pages.

Exercises (cont.):
24. Select “Window| Insert” from the Menu Bar to display the Insert Panel.
25. Click the drop-down to set the panel to “Layout.”
26. Click the “Draw AP Div” icon in the Insert Panel.
27. Click and drag within the document window to define the AP Div.
28. Click the drop-down to set the panel to “Common.”
29. Click within the AP Div.
30. Type “This is text in my AP Div.”
31. Click outside of the AP Div.
32. Select “File| Close” from the Menu Bar.
33. Select “File| Exit” from the Menu Bar to quit the application.
10.1 – SPRY WIDGETS, BEHAVIOR EVENTS AND ACTIONS:

In this lesson you will learn about Spry “widgets” and how to use them. Web pages use Spry so that it is easy for visitors to make selections. One of the most popular and useful interactive “widgets” is the drop-down menu. Other examples of useful widgets are collapsible panels, tabbed panels, and radio buttons. These widgets are made up of advanced code which works behind the scenes and which you luckily don’t have to understand in order to make use of. The widget appears on your web page and visitors can interact with it to make a selection or access more content with ease.

Events and Actions describe the relationships between triggering events and the resulting action viewed by the visitor. For example, a visitor might click on a hyperlink image and be linked to content on a different page. The visitor’s click is the “Event,” and the redirection to a new page is the “Action.” This scenario is known as an “onClick” event. Another example of an “Event” would be moving a mouse cursor over an image and the resulting “Action” would be the image being replaced with another image called a “rollover image.” This is known as an “onRollover” event.

Although it can be a bit tricky to understand the terminology of events and actions, Dreamweaver makes it easy to use them to your advantage without having to understand the complexities of how they function. In the next few lessons, you will learn how to use Spry widgets to give your websites complexity and style.
10.2 – CREATING A DROP-DOWN MENU:

In this lesson you will learn how to create a drop-down menu. Drop-down menus are widely used all over the Internet. Even within the Dreamweaver interface, drop-down menus allow you to access options which are not immediately visible. Once you click on the small black triangle or arrow, usually located to the right of some sort of text field, the other options then ‘drop-down’ into view.

You can also use drop-down menus on your web pages in a similar way. People viewing your website can use drop-down menus to navigate from page to page, input data, or make other types of selections.

To create a drop-down menu, first open a web page, and click within the document window to place the blinking cursor at the spot where you want the drop-down menu to go.

Next, click on the word “Common” in the “Insert” panel and select “Spry” from the options below. The “Spry Insert Panel” will now open. Next, click on the “Spry Menu Bar” option. A dialog box may appear prompting you to save your web page before you insert any widgets. Click “OK” and save your web page.

You will see that the “Spry Menu Bar” dialog box will open allowing you to choose between horizontally- or vertically-oriented tabs. Before you make this choice, bear in mind which would best suit your purposes based on the location of the menu within your web page. Make your selection by clicking inside the appropriate radio button and then click “OK”. Dreamweaver inserts a Spry Menu Bar into your page which you can now customize.
10.3 – EDITING A DROP-DOWN MENU:

In this lesson, you will learn how to edit a drop-down menu. Using techniques from the previous lesson, insert a drop-down menu into a web page.

Let’s edit the appearance of this drop-down menu. First, click on the blue Spry menu bar above the first Item box and the menu bar properties will appear within the Properties Inspector. Click Item 1 and type a name for that tab in the Text field as you want it to appear on your web page. Press the “Enter” key to confirm your choice. The name you have chosen will now appear both in the Spry menu as well as within the Properties Inspector.

Next, click on “Item 1.1” to name the first submenu tab. Enter the appropriate name for this tab in the Text field and then hit the Enter key. Repeat these steps for all of the tabs within your Spry Drop-down menu. To add or subtract an item or sub-item use the corresponding “+” or “-” button above its particular menu. To move an item up or down the list use the corresponding small black triangle to make adjustments.

It is also possible to make an item or sub-item serve as a hyperlink. To do this, click on the menu item that’s going to be a link, and then type in the URL into the Link field in the Properties Inspector; and then press the Enter key. If you want to link to a different page within the same website, you can just click the small folder icon to the right of the “Link” text field in the Properties Inspector, and navigate to find the page in your local root folder, and then click to select it. You can also edit the font type, colors, and other associated features of your menu by editing the corresponding CSS rules using the CSS panel.

When you are finished editing your drop-down menu, it is vital to save your page in order to preserve your Spry widget settings. Choose “Save” from the “File” drop-down menu found in the Menu Bar. Your page will be saved with your new Spry settings, and Dreamweaver will automatically create the necessary files which enable your drop-down menu widget to function.

Remember that the code in these files is what enables the widget to function, and it will be saved to a folder called “Spry Assets.” Dreamweaver creates this folder for you in your local root folder. For the drop-down menu to work, this folder must be uploaded to your hosting server along with the rest of your web site. It is important not to change the name or location of this Spry folder as the drop-down menu will not function without it.
10.4 – CREATING TABBED PANELS:

In this lesson, you will learn how to create a tabbed panel. Dreamweaver allows you to insert highly useful “tabbed panels” through the “Spry” menu. When you use these panels, you will be able to display a wide variety of content within a relatively small space on your web page. Each tab will be accessible to a visitor, allowing them to click on it to display its content. One tab could be a video clip, another could be a form to fill out, another tab could be a links page, or anything else you choose.

Let’s create a tabbed panel. First, click to place the blinking cursor at the spot on your page where you want to put the tabbed panel. Next, click the triangle to the right of the word “Common” in the Insert Panel, and choose “Spry.” The Insert Panel will change. Now click on “Spry Tabbed Panels.” You will be prompted to save your page. I’m going to call this one “Tabbelpannels.” Dreamweaver adds a tabbed panel to your page at the spot where you placed the blinking cursor.

Next, click on the blue bar just above the tabbed panel, which says “Spry Tabbed Panels: Tabbedpanels1.” This will choose the tabbed panel as the active element on your page, and you can then use the Properties Inspector to gather information and edit the tabbed panel. If you want to add another tab, for example “number three,” click on the small “+” icon within the Properties Inspector. I can also change the order of the tabs in the panel by clicking on the name of the tab in the Properties Inspector, and then using the “Move Up” and “Move Down” triangle icons to rank my tabs the way I want them.

You can add as many tabs to your panel as you like, but keep in mind that the more content you add, the longer your page will take to load in a browser window.
10.5 – ADDING CONTENT TO TABBED PANELS:

In this lesson, you will learn how to add content to tabbed panels. This will be the content visitors see once they click on an individual tab. Using techniques from the previous lesson, start by adding a tabbed panel to a web page.

Now let's add content to the tabbed panel. First, click the outside of the panel to select the tabbed panel as the active element of your page. You will see that the Properties Inspector displays information about the tabbed panel. You can now enter text, images or multimedia content to each of your tabbed panels.

Let's add a fact to the “Turtle Facts” tab. I'm going to click on “Turtle Facts” in the Properties Inspector, which will choose this tab as the active element. Now, I'm going to click-and-drag to highlight “Content 2,” and I'm going to type in “All turtles have shells.” Now I'm going to hit the “Enter” key on my keyboard to confirm this change. I could also paste in text from another source.

I can also add an image to the tabbed panel. Again, I click the outside of the tabbed panel to select it as the active element of the page. Then, I click to highlight “Turtle Pictures” in the Properties Inspector. I'm going to click-and-drag to highlight “Content 1,” and then I'm going to get rid of that text by hitting the “Delete” key on my keyboard. Now, I'm going to change the Insert panel back to “Common,” and then use it to insert an image into this part of my tabbed panel.

Again, I can add as much content as I like to this panel, but I have to keep in mind that as I add more content, the load time for my page increases.
10.6 – EDITING TABBED PANELS:

In this lesson, you will learn how to edit tabbed panels. Start by opening a page in Dreamweaver and inserting a tabbed panel into the document. You can edit a tabbed panel like you would edit CSS style rules, by using the CSS Styles panel.

First, click on the small “+” icon to the left of “Spry Tabbed Panels” in the CSS Styles panel. This expands the list of styles which appear in the panel. You can now click on a particular style name to view its properties in the Properties area of the panel. To get a better look at things, you can click-and-drag the borders of this panel to expand or contract them.

Let’s change the font size of the content in the “Turtle Facts” tab. First, click “Turtle Facts” in the Properties Inspector to select the Turtle Facts tab as the active element of the page. Then, double-click the name of the style you want to edit. I’m going to double-click the “.TabbedPanelsContent” style. This will open the “CSS Rule Definition” dialog box. Choose “Type” from the Category menu and then click on the downward pointing arrow to the right of the “font-size” text field. Choose “x-large” from the drop-down menu and then click “OK.”

You can use different colors to highlight various states for the tabs in your tabbed panel. To change the color of the tab that visitors see when they hover over the tab with their mouse, double-click on the “.TabbedPanelsTabHover” style. Next, choose “Background” from the Category menu, and then click on the “Background color” color square. Now choose a new color and then click “OK.” If you look at this page in Live View mode, and hover over the tabs, you will see that they now appear in your new color.

Sample - for evaluation purposes only!
10.7 – OPEN BROWSER WINDOW BEHAVIOR:

In this lesson, you will learn how to use the “Open Browser Window” behavior. Using Dreamweaver, you can make it so a visitor's mouse click will open a new browser window which you can size perfectly to suit its content. To do this, open a web page that contains at least one image. The image on your page is going to be the “launching element.” Start by clicking to choose the image as the active element, and choose “Behaviors” from the ‘Window’ drop-down menu found in the Menu Bar. This will open the ‘Behaviors’ area of the Tag Inspector panel.

Next, click the small black drop-down menu triangle next to the small ‘+’ icon in the panel, and select “Open Browser Window.” The “Open Browser Window” dialog box will open. Click the “Browse” button and the “Select File” dialog box will open. Now, click the drop-down menu triangle and navigate to locate the page that you want to open in the browser window. Click on the file to highlight it, and then click “OK.”

Please note that if you want to display someone else’s web page in the window, you can type in the URL in the “URL to Display” text field. You can now type into the “Window Width” text field the width in pixels that you want your new browser window to be. If you leave the “Height” text field blank, the window will proportion itself perfectly according to your content.

Next, click the appropriate checkbox for any attributes that you want the window to have. Finally, you can type a name for this new browser window, but be careful not to use any spaces or special characters in the name. Click “OK” to confirm your selections.

Once you have added a behavior, you can specify the corresponding event which triggers it. For the “Open Browser Window” behavior, you should consider the “onClick” event. To select the event, click just within the field to the left of “Open Browser Window” in the Tag Inspector panel. A drop-down arrow will appear. When you click it, a list of functions will descend. Click to select the triggering event. You will notice that its name is now displayed in the “Behaviors” panel.

Let’s now preview this page in Mozilla Firefox. When the browser window opens, I can click on the image, and the new browser window opens with my exact specifications.
10.8 – ABOUT FORMS:

In this lesson, you will learn how to add forms to your web page. Using forms in web pages can be tricky; not because of Dreamweaver’s settings, but because different web hosts have different rules about how forms work. Your best bet, if you want to include a form on your page, is to contact your web hosting provider directly, and ask about their specific rules for using forms. Your hosting provider will often give you the exact code, or script, that their rules require you to use.

Let’s insert a form onto a web page. To insert a form, you must first define a “form container” in which to place your form. To do this, first click the black triangle to the right of the word “Common” in the Insert panel, and choose “Forms.” Next, click to place the blinking cursor at the spot on your web page where you want to put the form. Now click the “Form” icon in the Insert panel. A dotted red box will appear to confirm that a form container has been established.

Next, type the address of the form handling script into the “Action” text field within the Properties Inspector. Again, it will be necessary for you to contact your web hosting provider in order to obtain a correct address for the form handling script. Now click the small black drop-down arrow next to the “Method” text field, and choose either “POST” or “GET.” Again, which one you choose will depend on the type of form handling script you are using on your particular hosting server.

Once you have done this, you will be ready to insert form elements into your newly positioned container.
10.9 – ADDING TEXT FIELDS TO FORMS:

In this lesson, you will learn how to add text fields to forms so that visitors may interact with your website and submit information to you by filling out a form. Forms allow visitors to leave comments about your web page, ask a question, or provide some other type of information. Begin by adding a form container to a web page, using the techniques from the previous lesson.

Now, let’s add a text field to this form. First, click on the inside of the form container. Next, make sure that the “Insert” panel is set to “Forms,” and then click the “Text Field” icon. The “Input Tag Accessibility Attributes” dialog box will open. Type in a one-word description for this new blank text field so that visitors can identify it. I’m going to type “Name.” Below this, in the “Label” text field, type the text that visitors will see next to your blank text field. I’m going to type “Your Name Here.”

If you want the text to appear on the left of the text field, click the “Before Form Item” radio button. If you want the text to appear on the right side of the text field, click the “After Form Item” radio button. Click “OK” to confirm your choices.

You will see a text field appear according to your selections. The label text that you just inserted now appears next to the blank text field. If you want more than one line visible on the page, select the “Multi-Line” radio button. You might want to do this for a comment field where more than one line of information will be submitted.

You can type a character width for the text field, and choose a maximum character limit if you want. This will limit the amount of text that someone can type into the field. Click-and-drag on the label text and select from the formatting options in the Properties Inspector to edit your text field.
10.10 – INSERTING CHECKBOXES INTO FORMS:

In this lesson, you will learn how to add a checkbox to your form. Checkboxes allow visitors to easily select from a number of possible choices on your web page. With checkboxes, visitors can make a selection with a click of their mouse.

Let’s add a checkbox to this form. First, click to place the blinking cursor inside of your form container. Next, make sure the Insert panel is set to “Forms.” Now click the “Checkbox” icon within the Insert panel. This will open the “Input Tag Accessibility Attributes” dialog box. Type a description in the ID text field – I’m going to type “Alert” – and then insert the text you want to appear next to the checkbox. In the “Label” text field I’m going to type “Check this box to receive email alerts.” This is what visitors will see on your page.

Next, select whichever Style and Position possibilities you want by clicking within the appropriate radio button and then click “OK.” The dialog box will close, and you will see that the checkbox and label that you chose appear on your page. You can repeat these steps to insert additional checkboxes if you want. If you click on a checkbox, you will select it as the active element on your page, and you can then use the Properties Inspector to edit the checkbox however you like.

If you are not sure whether to use checkboxes or radio buttons on your page, keep in mind that with checkboxes, viewers can make more than one choice. With radio buttons, viewers can only make one choice. In other words, checkboxes will allow more than one box to be checked at one time. When you click a radio button, however, any other radio button that was previously clicked becomes un-clicked.
10.11 – INSERTING RADIO BUTTONS INTO FORMS:

In this lesson, you will learn how to use radio buttons on your web page. Radio buttons allow visitors to select one option by clicking to fill a button space. Remember, if you want a visitor to be able to choose more than one option on the page, you should use checkboxes. Radio buttons are only appropriate if the person viewing your page will only be able to make one selection.

Let’s insert a radio button into a web page. Using techniques from previous lessons, start by inserting a form container into a web page, and make sure that the Insert panel is set to “Forms.” Next, click inside of the form container, and click the “Radio Button” icon found in the Insert panel. The “Input Tag Accessibility Attributes” dialog box will appear, and you can insert a one-word description into the “ID” text field, and type in the text which will appear on the page next to the radio button into the “Label” text field.

You can also select the Style and Position settings for this button by clicking the relevant radio button. I’m going to set this one to “After Form Item.” Click “OK” to confirm your selections. Dreamweaver inserts a radio button into your page.

Repeat these steps until you have as many radio buttons on the page as you need. You can click on a radio button and choose its “Initial State” by making the appropriate selection in the Properties Inspector. You can also change the button’s other attributes within this panel. You can even use the Properties Inspector to edit your radio button’s text. To do this, click-and-drag to select the text, set the Properties Inspector to the “HTML” settings, and then edit as you would any other text.

If I look at this page in “Live View” mode, the red form container outline disappears, and I can see that my text is formatted according to my selections. I can also see that the radio buttons are functioning properly.
10.12 – INSERTING LISTS AND MENUS INTO FORMS:

In this lesson, you will learn how to insert lists and drop-down menus into forms. Using drop-down lists is a good way to provide lots of information while keeping your web page looking neat. To begin, insert a form container into a web page, and make sure that the Insert panel is set to “Forms.”

Let’s insert a drop-down list into this web page. First, click to place the blinking cursor within the form container. Next, choose “Select (List/Menu)” from the Insert panel. The “Input Tag Accessibility Attributes” dialog box will open. Type a one-word description for your list into the “ID” text field—I’m going to type in “supplies.” Next, type a label to identify your list in the “Label” text field. This will be the text that will be next to the list on your web page. I’m going to type in “School Supplies.” Check the appropriate radio button to place the text either before or after your drop-down list, and then click “OK” to confirm your selections.

You will see a blank drop-down menu appear in the form container. Now, click within the menu’s text field to select it. Next, click on the “List Values” button found in the Properties Inspector. The “List Values” dialog box will open. Click in the white space below “Item Label,” and type in your text for each menu item. These will be the items on your drop-down list. I’m going to make this one “Books.”

To add more menu items, click the ‘+’ icon in the “List Values” dialog box. A new text field will appear below the first menu item. Type in the next item on your list—I’m going to type “Pencils.” Repeat this process until you complete your list. If you want to move an item up or down the list, you can do so by first clicking on the item you want to move, and then using the small black “move up” and “move down” triangle icons to adjust the ranking of your items. When you are done creating your list, click “OK” to confirm your selections.

The list items you entered are now in the drop-down list. However, visitors will only see one item at first, before clicking into the menu. To choose which item is first seen by visitors, click to select it from the “Initially Selected” field in the Properties Inspector.

If we look at this page using “Live View” mode, the red dotted form container disappears, and I can see that my drop-down list is functioning perfectly.
10.13 – ADDING BUTTONS TO FORMS:

In this lesson, you will learn how to add a button to a form. Without a “Submit” button on your form, visitors will not be able to send you the information or selections they have entered on your web page. When someone clicks the “Submit” button on your page, the information is sent to the form handling script, which will be located on your web hosting server. It is always a good idea to include a “Reset” or “Clear” button next to the “Submit” button, so that people can clear their choices if they make a mistake and need to start over.

To begin, insert a form container into your web page using techniques from previous lessons, and make sure that the Insert panel is set to “Forms. Next, click inside the form container where you want to place a button. Then, click the “Button” icon found in the Insert panel. The “Input Tag Accessibility Attributes” dialog box opens. Type in a one word description for this button into the “ID” text field—I’m going to type “submit.” The button will speak for itself, so there is no need to type a label for it into the “Label” text field. Click “OK” to confirm your selections. If you see a pop-up window asking if you want to add a form tag, click “yes.” You can check the “don’t show me this message again” option if you want to automatically add a form tag every time, which is a good idea.

You will see a Submit button appear in the form container in your document window. To rename the button, first click on it. Next, click and drag to highlight the current name in the “Value” text field in the Properties Inspector. Type in a new button name—I’m going to type “Send,” and press the Enter key. You will see that the text on your button changes to reflect your choice.

To add a “reset” or “clear” button, first click to place your mouse cursor in the form container where you want to place the button. Let’s put a “Reset” button next to the “Send” button. Click on the “Button” icon from the “Insert” panel. The “Input Tag Accessibility Attributes” dialog box opens. I’m going to type “Reset” into the “ID” text field, and click “OK” The new button appears in the form container.

You will see that the button currently reads “Submit”. To change the text, click on the button to select it and then click and drag to highlight “Submit” in the “Value” text field in the Properties Inspector. Type in “Reset” and then hit the Enter key. The text on the new button changes to “Reset.” Next, click on the “Reset Form” radio button in the Properties Inspector to indicate that clicking on this button will reset the form once it has been uploaded to your web hosting server.
**CREATING A DROP-DOWN MENU:**

1. Click to place the blinking cursor at the spot on the web page where you want to insert a drop-down menu.
2. Set the “Insert” panel to “Spry.”
3. Click on the “Spry Menu Bar” icon in the “Insert” panel.
4. Using the “Spry Menu Bar” dialog box, choose between horizontal and vertical tabs.
5. Click “OK” to confirm your selections.

**EDITING A DROP-DOWN MENU:**

1. Insert a drop-down menu into a web page.
2. Click on the blue “Spry” menu bar above the first Item box.
3. Click “Item 1.”
4. Type a name for the tab in the “Text” field.
5. Press the “Enter” key on your keyboard to confirm your changes.
6. Click on “Item 1.1” to name the first submenu tab.
7. Enter the appropriate name for this submenu tab into the “Text” field, and hit “Enter” to confirm your choices.
8. Continue in this manner until you have edited your drop-down menu.

**CREATING A TABBED PANEL:**

1. Click to place the blinking cursor at the spot on your page where you want to add a tabbed panel.
2. Set the “Insert” panel to “Spry.”
3. Click the “Spry Tabbed Panels” icon in the “Insert” panel. Dreamweaver will insert a tabbed panel into your page.
4. Click on the blue “Spry Tabbed Panels” bar just above the tabbed panels.
5. Use the Properties Inspector to edit your tabbed panel.
ADDITION CONTENT TO A TABBED PANEL:
1. Insert a tabbed panel into a web page.
2. Click on the outside of the tabbed panel to select the panel as the active element of the page.
3. Use the Properties Inspector to edit the panel’s contents.
4. Use the “Insert” panel to add content to the tabbed panel.

USING THE OPEN BROWSER WINDOW BEHAVIOR:
1. Click to select a “launching image” from a web page.
   OR
1. Click-and-drag to select “launching text” from a web page.
2. Choose “Behaviors” from the “Window” drop-down menu in the Menu Bar.
3. In the “Behaviors” area of the “Tag Inspector” panel, click the small black drop-down triangle next to the small “+” icon.
4. Select “Open Browser Window.” This will open the “Open Browser Window” dialog box.
5. Click the “Browse” button. This will open the “Select File” dialog box.
6. Navigate to locate the page that you want to open in the new browser window.
7. Click to highlight the page.
8. Click “OK.”
9. Type a pixel width for your new browser window into the “Window Width” text field.
10. Click the appropriate checkbox for any attributes that you want the window to have.
11. Type a name for your new browser window.
12. Click “OK” to confirm your selections.
13. Click just within the field to the left of “Open Browser Window” in the “Tag Inspector” panel. A drop-down arrow will appear.
14. Click the drop-down arrow, and select the triggering event.
INSERTING A FORM CONTAINER INTO A WEB PAGE:
1. Set the “Insert” panel to “Forms.”
2. Click to place the blinking cursor at the spot on the web page where you want to insert the form container.
3. Click the “Form” icon in the “Insert” panel.
4. Type the address of the form handling script into the “Action” text field within the Properties Inspector.
5. Click the small black drop-down arrow next to the “Method” text field, and choose either “POST” or “GET.”

ADDING A TEXT FIELD TO A FORM CONTAINER:
1. Insert a form container into a web page.
2. Make sure the “Insert” panel is set to “Forms.”
3. Click to place the blinking cursor inside of the form container.
4. Click the “Text Field” icon in the “Insert” panel. This will open the “Input Tag Accessibility Attributes” dialog box.
5. In the “ID” text field, type in a one-word description for your text field.
6. In the “Label” text field, type the text that will appear on your web page next to your text field.
7. Choose either “Before Form Item” or “After Form Item” by clicking the appropriate radio button.
8. Click “OK” to confirm your choices. Dreamweaver will add a text field to your page.
9. Edit the text field using the Properties Inspector.
INSERTING CHECKBOXES INTO FORMS:
1. Insert a form container into a web page.
2. Make sure the “Insert” panel is set to “Forms.”
3. Click to place the blinking cursor within the form container.
4. Click the “Checkbox” icon in the “Insert” panel. This will open the “Input Tag Accessibility Attributes” dialog box.
5. In the “ID” text field, type a one-word description for the checkbox.
6. In the “Label” text field, type the text which will appear next to the checkbox on the web page.
7. Choose either “Before Form Item” or “After Form Item” by clicking the appropriate radio button.
8. Click “OK” to confirm your choices. Dreamweaver will add a checkbox to your page.
9. Edit the checkbox using the Properties Inspector.

INSERTING RADIO BUTTONS INTO FORMS:
1. Insert a form container into a web page.
2. Make sure the “Insert” panel is set to “Forms.”
3. Click to place the blinking cursor within the form container.
4. Click the “Radio Button” icon in the “Insert” panel. This will open the “Input Tag Accessibility Attributes” dialog box.
5. In the “ID” text field, type a one-word description for the radio button.
6. In the “Label” text field, type the text which will appear next to your radio button on the web page.
7. Choose either “Before Form Item” or “After Form Item” by clicking the appropriate radio button.
8. Click “OK” to confirm your choices. Dreamweaver will add a radio button to your page.
9. Edit the radio button using the Properties Inspector.
INSERTING LISTS AND MENUS INTO FORMS:
1. Insert a form container into a web page.
2. Make sure the “Insert” panel is set to “Forms.”
3. Click to place the blinking cursor within the form container.
4. Click “Select (List/Menu)” in the “Insert” panel. This will open the “Input Tag Accessibility Attributes” dialog box.
5. In the “ID” text field, type a one-word description to describe the list or menu.
6. In the “Label” text field, type the text which will appear next to your list or menu on the web page.
7. Choose either “Before Form Item” or “After Form Item” by clicking the appropriate radio button.
8. Click “OK” to confirm your choices. Dreamweaver will add a drop-down menu to your page.
9. Click within the menu’s text field to select it.
10. Click the “List Values” button in the Properties Inspector. This will open the “List Values” dialog box.
11. Use the “List Values” dialog box to add items and edit your drop-down menu.

ADDING A BUTTON TO A FORM:
1. Insert a form container into a web page.
2. Make sure the “Insert” panel is set to “Forms.”
3. Click to place the blinking cursor within the form container.
4. Click the “Button” icon in the “Insert” panel. This will open the “Input Tag Accessibility Attributes” dialog box.
5. In the “ID” text field, type a one-word description to describe the button.
6. Leave the “Label” text field blank.
7. Click “OK” to confirm your selections.
8. If a pop-up window asks if you want to add a form tag, choose “Yes.” Dreamweaver will add a “Submit” button to your page.
9. Click the new button to select it as the active element of the page.
10. Edit the button using the Properties Inspector.
EXERCISES—
SPRY WIDGETS & FORMS

**Purpose:**
1. To be able to add spry and widgets into a web page.

**Exercises:**

1. Open your Dreamweaver application.
2. Ensure that you have the “Dreamweaver Test Site” open.
4. Select “Blank Page” from the “Category:” list at the left side of this dialog box.
5. Select “HTML” in the “Page Type:” list in the middle of the dialog box.
6. Click the “Create” button in the lower right corner of the “New Document” dialog box.
7. Select “File| Save As…” from the Menu Bar.
8. Ensure that you have the “root” folder selected in the “Save in:” drop-down.
9. Type “spry” into the “File name:” text box.
10. Click the “Save” button in the lower right corner of the “Save As” dialog box.
11. Click into the “spry.htm” document.
12. Select “Window| Insert” from the Menu Bar to display the Insert Panel.
13. Click on the drop-down and select “Spry.”
14. Click on “Spry Menu Bar” from the list of choices.
15. Select “Horizontal” in the “Spry Menu Bar” dialog box.
16. Click “OK.”
17. Click on the blue “Spry Menu Bar” above the first Item box.
18. Click Item 1 in the new Menu Bar and type “Pages.”
19. Click on the blue “Spry Menu Bar” above the first Item box.
20. Click on “Item 1.1” and change the name to “Yahoo”
21. Click on “Item 1.2” and change the name to “Google”
22. Click on the blue “Spry Menu Bar” above the first Item box.
23. Click on “Item 1.3” in the Properties Inspector to select it.
24. Click the “-” button to delete it.
25. Click on “Item 2” in the Properties Inspector to select it.
26. Click the “-” button to delete it.
27. Click on “Item 3” in the Properties Inspector to select it.
28. Click the “-” button to delete it.
29. Confirm the deletion of the menu, if prompted.
30. Click on “Item 4” in the Properties Inspector to select it.
31. Click the “-” button to delete it.
32. Click on the blue “Spry Menu Bar” above the first Item box.
33. Click on the “Yahoo” item we created.
34. In the “Link” text box, enter “http://www.yahoo.com.”
35. Click on the “Google” item we created.
36. In the “Link” text box, enter “http://www.google.com.”
37. Press “F12” on your keyboard to test the page and links.
38. Select “File| Close” from the Menu Bar.
39. Select “File| Exit” from the Menu Bar to quit the application.
**EXERCISES—Spry Widgets & Forms**

**Purpose:**
1. To be able to create a basic web form.

**Exercises:**

1. Open your Dreamweaver application.
2. Ensure that you have the "Advanced Test Site" opened in Dreamweaver.
3. Select "File| New..." from the Menu Bar.
4. Select "Blank Page" in the "Category:" list at the left side of the "New Document" dialog box.
5. Select "HTML" in the "Page Type:" list in the "New Document" dialog box.
6. Click the "Create" button at the bottom of the "New Document" dialog box.
7. Click into the new, blank web page.
8. Select "Insert| Form| Form" from the Menu Bar.
9. In the "Properties" Inspector, type "RegistrationForm" into the "Form name" text box.
10. Click into the dashed, red border of the form.
11. Select "Insert| Table" from the Menu Bar.
12. Type "8" into the "Rows:" text box.
13. Type "2" into the "Columns:" text box.
14. Type "100" and then select "percent" from the "Table width:" section.
15. Enter a "0" for the "Border thickness:" "Cell padding:" and "Cell spacing:".
16. Click "OK" to insert the table into the form.
17. Click and drag over the top two cells in the first row to select them.
18. Select "Modify| Table| Merge Cells" from the Menu Bar.
19. Click and drag over the next two cells in the next row below to select them.
20. Select "Modify| Table| Merge Cells" from the Menu Bar.
21. Click into the topmost merged cell and type "Registration Form."
22. Click and drag over the text to select it, and click the "Align Center" button in the "Properties" panel.
23. Use the "Format:" drop-down in the "Properties" Inspector to select "Heading 1."
24. Click into the merged cell in the second row, and type "All sessions start at 8:00 AM."
25. Click and drag over the text to select it, and click the "Align Center" button in the "Properties" panel.
26. Use the "Format:" drop-down in the "Properties" Inspector to select "Heading 6."
27. Skip a row, and click into the left cell of the fourth row. Type "Registrant Name:" into this cell.
28. Click into the cell below that one and type "Session to Attend:".
29. Click into the cell below that one and type "Day to Attend:".
30. Click and drag the right edge of the left column to the left until it falls a little to the right of the labels which you entered.
31. Click into the cell to the right of the "Registrant Name:" cell.
32. Select "Insert| Form| Text Field" from the Menu Bar. Click "Cancel!" in the "Input Tag Accessibility Attributes" dialog box which appears.
33. In the "Properties" Inspector, type "RegName" into the "TextField" text box.
34. Type "50" into the "Char width" text box.
35. Click into the cell to the right of the "Session to Attend:" cell.

(cont.)
36. Select “Insert| Form| Select (List/Menu)” from the Menu Bar. Click “Cancel” in the “Input Tag Accessibility Attributes” dialog box which appears.

37. Type “Session” into the “List/Menu” text box in the “Properties” Inspector.

38. Click the “List Values…” button in the “Properties” Inspector to open the “List Values” dialog box.

39. Type “Making Forms” into both the “Item Label” and the “Value” columns.

40. Click the button that looks like a plus sign to add another choice.

41. Type “Managing Web Sites” into both the “Item Label” and the “Value” columns of the new entry.

42. Click the button that looks like a plus sign to add another choice.

43. Type “Making Choices” into both the “Item Label” and the “Value” columns of the new entry.

44. Click “OK” in the “List Values” dialog box.

45. Click on “Making Forms” in the “Initially selected” list in the “Properties” Inspector.

46. Click into the cell to the right of the “Day to Attend:” cell in the table.

47. Select “Insert| Form| Radio Group” from the Menu Bar.

48. Type “DOW” into the “Name:” text box at the top of the “Radio Group” dialog box.

49. Click into the first row in the “Radio buttons:” list and type “Saturday” in both the “Label” and “Value” columns.

50. Click into the second row in the “Radio buttons:” list and type “Sunday” in both the “Label” and “Value” columns.

51. Click the “OK” button in the “Radio Group” dialog box.

52. Click and drag over the bottom two cells within the table to select them.

53. Select “Modify| Table| Merge Cells” from the Menu Bar.

54. Select “Format| Align| Center” from the Menu Bar.

55. Click into the merged and centered cell.

56. Select “Insert| Form| Button” from the Menu Bar. Click “Cancel” in the “Input Tag Accessibility Attributes” dialog box which appears.

57. Click to place the insertion point to the right of the button that you just inserted into the cell.

58. Select “Insert| Form| Button” from the Menu Bar. Click “Cancel” in the “Input Tag Accessibility Attributes” dialog box which appears.

59. Click to select the second button.

60. In the “Properties” Inspector for the second button, type “Reset” into the “Button Name” text box and the “Value” text box.

61. Select the “Reset form” option button in the “Action” section.

62. Select “File| Save As…” from the Menu Bar.

63. Save the web page with the name of “form.htm” into the “AdvancedRoot” folder.

64. Click the “Save” button when you are ready to save the file.

65. Select “File| Close” from the Menu Bar to close the web page form.

66. Select “File| Exit” from the Menu Bar when you are ready to exit the application.
CHAPTER 11-
PUBLISHING YOUR WEBSITE

11.1 - Domain Names Versus Web Hosting
11.2 - When is My Site Ready to Publish?
11.3 - Setting Up a Remote Site
11.4 - Connecting to a Remote Site
11.5 - Putting Files on the Remote Site
11.6 - Cancelling Uploads and Deleting Remote Site Files
11.7 - Downloading Files from the Remote Site
11.1 – DOMAIN NAMES VERSUS WEB HOSTING:

In this lesson, you will learn about domain names and web hosting. Before you can publish your site to the Internet, you will have to register a domain name and obtain hosting on a web server.

A domain name is simply your website’s name, for example “carvedturtles.com.” When someone types your domain name into a search engine or into the address field of a web browser, your domain name points the browser to your website’s URL, or web address. You will often have to pay a fee in order to register a domain name.

Web hosts are service providers with special computers called “servers.” Computers with servers are able to “serve” websites to the Internet. Most of the time, you have to pay a monthly or yearly fee for web hosting service, although many schools and organizations provide web hosting to their students and members. When your site is ready to be published to the Internet, you will have to contact a web hosting service in order to upload your site files to the web server. Your web server is sometimes known as the “remote site,” and you will connect your computer to the remote site in order to transfer copies of all of the files that you have created in Dreamweaver, along with all of the associated images and other content that will be part of your site. Your web host will keep all of these files on the remote server computer, which allows your files to be viewable on the Internet even when your computer is turned off.

The simplest way to register a domain name and get web hosting is to find a business that provides both services. A quick search of the Internet should lead you in the right direction. Several companies even offer free domain name registry when you purchase a web hosting package. These types of offers can save you money and make setting up your website much simpler. If you already own a domain name, make sure to have the information about your domain name available to give to your new web host when you obtain hosting service.
11.2 – WHEN IS MY SITE READY TO PUBLISH?:

In the early days of the Internet, publishing a website was much more complicated and messy than it is now. Back then, it was very common to visit websites that were “Under Construction.” That happened because, in those days, you had to upload files to a server before you could see what the site would actually look like once it was online. So you essentially were publishing the site and then working out any issues with the site after you published.

Thankfully, Dreamweaver provides several ways to review your site before you publish to the Internet. You can, and should, use the “Live View” button often while designing your site in Dreamweaver, so that you can keep track of what your site will look like even before previewing in a browser window.

Another essential thing to do before publishing your site is to preview the site in as many different web browsers as possible. If you haven’t added additional browsers to Dreamweaver’s preview list, see the lesson, “Multi-Browser Previews.” Before deciding that your site is ready to publish, you should absolutely preview in several browsers.

Finally, it’s a good idea to check your site for broken links before deciding to publish. To do this, choose “Check Links Sitewide” from the “Site” drop-down menu found in the Menu Bar. This will open a panel that will show you a list of any broken links on your site.

When you have previewed your site in several browsers, and you’re confident that you don’t have any broken links, you are ready to publish your website.
11.3 – SETTING UP A REMOTE SITE:

In this lesson, you will learn how to set up your remote site within Dreamweaver, so that you can upload files from your local computer to the remote web host. Before continuing with this lesson, make sure that you have obtained a web hosting service. To complete this lesson, you will need to have three pieces of information regarding your web host: Your FTP address, your username, and your password for your web host. If you don’t have all three of these pieces of information, you will not be able to set up a remote site within Dreamweaver.

Let’s set up a remote site. First, choose “Manage Sites” from the “Site” drop-down menu. This will open the “Manage Sites” dialog box. Click on the name of your site, and click the “Edit” button. This will open the “Site Setup” dialog box. Next, click “Servers” found on the left side of the “Manage Sites” dialog box. Then click the plus-sign “Add New Server” icon found towards the bottom left of the “Site Setup” dialog box. This will open up another dialog box where you can enter your remote site information.

In the “Server Name” text field, type in a name that defines your web hosting service. Where you see “Connect using,” make sure that “FTP” is selected. Next, click inside the “FTP Address” text field and type your FTP address. Be very careful to spell everything correctly and don’t put any spaces into your FTP address. Next, click into the “Username” text field and type your web hosting user name. Then click within the “Password” text field and type in your web hosting password. Next, click into the “Root Directory” text field and type the directory path of your site. Next, click “Save.” This will close the dialog box. Click “Save” again to close the “Site Setup” dialog box. Finally, click “Done” in the “Manage Sites” dialog box. Your remote site is now set up.
PUBLISHING YOUR WEBSITE

11.4 – CONNECTING TO A REMOTE SITE:

In this lesson, you will learn how to connect your local computer to your remote web host, so that you can transfer files to your remote server. Before doing this, you must have obtained a domain name and web hosting service; and you must also have set up your remote site within Dreamweaver. If you haven’t done these things yet, you won’t be able to connect to a remote site.

Let’s connect our local computer to the remote site. First, make sure that the “Files” panel is visible. You may want to grab this panel by the panel tab to detach it from the main panel grouping. This will make it a floating panel, and you can resize it so that you can see all of your files.

Once you have the “Files” panel expanded in front of you, click the “Connect” button to connect to your web server. The “Connect” button is the icon in the “Files” panel with the two plugs facing each other. When the “Connect” button changes from two disconnected plugs into two connected plugs, you have established a connection with the remote site. You can now begin transferring your files to the remote server.

If you do not transfer any files between your site and the remote site for thirty minutes, Dreamweaver will automatically disconnect your local computer from the remote computer. To prevent Dreamweaver from disconnecting you choose “Preferences” from the “Edit” menu in the Menu bar. This will open the “Preferences” dialog box. Choose “Site” from the “Category” menu on the left. You will now see the “FTP Connection” text field. You can click into the text field and change the value, or uncheck the box to the left of “Disconnect.” Changing Dreamweaver’s disconnect preferences; however, will not stop the remote host from disconnecting you if you don’t transfer files within the host’s allotted time. If you change Dreamweaver’s disconnect preferences and find yourself still being disconnected, you are probably being disconnected by the remote host.
11.5 – PUTTING FILES ON THE REMOTE SITE:

In this lesson, you will learn how to upload files to your remote site. Before attempting to upload files, make sure that you have completed all of the previous lessons in this chapter.

When you are communicating with your remote site, you will be doing two main things: “Getting” and “Putting” files. “Getting” files from the remote server is the same thing as downloading files from the Internet—you bring a copy of a file from a remote computer to your local computer. “Putting” files is the same as uploading files to a web server—you are sending copies of files from your local computer to a remote site. Let’s look at how this works.

First, make sure that the “Files” panel is expanded within the Dreamweaver workspace, so that you can see all of its buttons, as well as the windows that show the “Remote Server” and “Local Files.”

The “Get” and “Put” buttons are located in the “Files” panel. The “Get” button is green and points downward. The “Put” button is blue, and points upward. You can remember which is which by thinking about how “Getting” and downloading are the same, so the arrow points down. “Putting” and uploading are the same, so the arrow points up. Let’s put a file on the remote server.

I’m going to put a thumbnail image on my website. In the Local Files panel, click once to highlight the file and then click the blue “Put” icon.

If you want to publish your entire site at once, the easiest thing to do is to click on the root folder of your site, which contains all of the files that make up your site, to highlight the folder, and then click the “Put” button in the “Files” panel. This will open a pop-up window that asks if you’re sure you want to put the entire site. Click “OK.” You will see the file appear in the “Remote Server” area of the panel once the upload is complete.

When you upload an entire site Dreamweaver will open a “Background File Activity” window that will show you the progress as your site is put onto the remote server. Depending on how many pages, files, and large graphics are included with your site, this can take a few minutes, especially if your Internet connection is slow. When the window disappears, your files have completed uploading, and have now been “put” on the remote server. You will also see that Dreamweaver shows you the files in the “Remote Server” window now, as well. Now, using the “Files” panel, you can easily compare your local files to your remote files.

Now that your files have been uploaded to the remote server, your website should be visible on the Internet. Some hosting services, however, can take several hours to “catch up” with your uploaded files, and you may have to wait a bit before seeing your site online.
11.6 – CANCELLING UPLOADS AND DELETING REMOTE SITE FILES:

In this lesson, you will learn how to cancel uploads to your remote server and delete files from the remote server. Before continuing, make sure that you have completed the previous lesson, “Putting Files on the Remote Site.”

To cancel putting files onto the remote server, simply hit the “Cancel” button in the “Status” dialog box while your files are uploading.

If you want to delete files that you have previously put onto the remote server, follow these steps. First, connect to the web server by clicking the “connect” icon in the “Files” panel. Once you are connected, you will see all of the files that you have put on the remote site listed in the “Remote Files” window on the left of the “Files” panel. To delete one or more of these files, simply click to select the file, and then press the “Delete” key on your keyboard. A dialog box will open, asking if you really want to delete the file. Click “Yes.” You will see the file disappear.

Sample- for evaluation purposes only!

![Image of remote site files and delete confirmation dialog box]
11.7 – DOWNLOADING FILES FROM THE REMOTE SITE:

In this lesson, you will learn how to download files from your remote server. In order to complete this lesson, you will need to have previously uploaded, or “put,” files onto the remote site.

First, make sure that the “Files” panel is open, and that all of your files are visible in the “Remote Server” and “Local Files” areas of the “Files” panel. Next, click the “Connect” icon found in the “Files” panel to connect to the remote host.

Once you are connected to the remote server, click within the “Remote Server” window of the “Files” panel to select the file you want to download. When the file is highlighted, click the downward-pointing green arrow “Get” icon located in the “Files” panel. A dialog box may open, asking if you also want to include dependent files. A dependent file is a separate file associated with a particular page, for example, an image. If you see this popup, click “Yes.” The “Background File Activity” dialog box will appear, and it will update the progress of your download. If a copy of the same file already exists on your local computer, a dialog box may appear and ask if you would like to overwrite your previous file. Click according to whether or not you would like to overwrite the existing file. The dialog box will close, and your download is complete.
PREPARING TO PUBLISH:
1. Use “Live View” often while designing pages.
2. Preview the site in as many different browsers as possible.
3. Check site for broken links by choosing “Check Links Sitewide” from the “Site” drop-down menu in the Menu Bar.

SETTING UP A REMOTE SITE:
1. Obtain web hosting service.
2. Gather information about your web host: Your FTP address, your username, and your password for your web host.
3. Choose “Manage Sites” from the “Site” drop-down menu in the Menu Bar. This will open the “Manage Sites” dialog box.
4. Click on the name of your site.
5. Click the “Edit” button. This will open the “Site Setup” dialog box.
6. Click “Servers” from the left side of the dialog box.
7. Click the “+” “Add New Server” icon. This will open another dialog box.
8. In the “Server Name” text field, type in a name that defines your web hosting service.
9. Select “FTP” next to “Connect Using.”
10. Click inside of the “FTP Address” text field, and type your FTP address.
11. In the “Username” text field, type in your web hosting user name.
12. In the “Password” text field, type in your web hosting password.
13. In the “Root Directory” text field, type the directory path of your site.
14. Click “Save” to close the dialog box.
15. Click “Save” again to close the “Site Setup” dialog box.
16. Click “Done” in the “Manage Sites” dialog box.
ACTIONS -
Publishing Your Site

CONNECTING TO A REMOTE SITE:
1. Set up your remote site within Dreamweaver.
2. Detach the “Files” panel and expand it so that its contents are fully visible.
3. Click the “Connect” icon in the “Files” panel.

PUTTING FILES ON THE REMOTE SITE:
1. Expand the “Files” panel so that its contents are fully visible.
2. Connect to the remote site.
3. In the “Local Files” area of the “Files” panel, click to highlight the file/s that you want to upload to the remote site.
4. Click the blue arrow “Put” icon in the “Files” panel.

DELETING FILES FROM THE REMOTE SITE:
1. Expand the “Files” panel so that its contents are fully visible.
2. Connect to the remote site.
3. In the “Remote Files” area of the “Files” panel, click to highlight the file/s that you want to delete.
4. Click the “Delete” key on your computer’s keyboard.
5. A dialog box will ask if you really want to delete the file. Click “Yes.”

DOWNLOADING FILES FROM THE REMOTE SITE:
1. Expand the “Files” panel so that its contents are fully visible.
2. Connect to the remote site.
3. In the “Remote Files” area of the “Files” panel, click to highlight the file/s that you want to download to your local computer.
4. Click the green arrow “Get” icon in the “Files” panel.
EXERCISES-
Publishing Your Site

Purpose:
1. There are no exercises for this chapter.

Exercises:
1. None.
CHAPTER 12-
WEBSITE MANAGEMENT

12.1 - Site Assets
12.2 - Changing Links Site-Wide
12.3 - Finding and Replacing Text
12.4 - Site Reports
12.5 - Checking Files In and Out
12.6 - Using Design Notes
12.1 – SITE ASSETS:

In this lesson, you will learn about Dreamweaver’s Assets panel. The Assets panel is one of the best tools available for managing your site’s various elements. “Assets” are simply the various elements used to make up your web pages, such as images, hyperlinks, video files, and so forth.

First, make sure that the “Assets” panel is visible. If it is not, click “Assets” from the “Window” drop-down menu found in the Menu Bar. For the purposes of this lesson, let’s detach the “Assets” panel from its panel grouping, and make it a floating panel. Then I can enlarge it so that I can see all of its contents.

Down the left side of the “Assets” panel, you will see a column of icons. These represent the different type of elements, or assets, being used in my carved turtles website. When I click on the “Images” icon, the “Assets” panel displays all of the images used on my site. If I click the “Colors” icon, the “Assets” panel displays all of the colors used on my site, and so on. This is a great way for me to see all of the files from my site all in one place.

Now click the “Images” icon in the “Assets” panel to display the images used in your site. Notice how, when I click on one of the file names, the “Assets” panel shows me a small thumbnail version of the image. I can even highlight an image and then click the “Add to Favorites” icon in the bottom right corner of the “Assets” panel, and Dreamweaver will make note that this is a favorite image. This is a very handy feature, especially if your website includes many images. You can turn common images like banners and logos into favorites, and then find them easily later by clicking the “Favorites” radio button at the top of the “Assets” panel.
12.2 – CHANGING LINKS SITE-WIDE:

In this lesson, you will learn how to replace all of the hyperlinks on your site that point to the same specific address. This is something that you will do when you delete or rename a page, and want to update all of the links to that page.

First, choose “Change Link Sitewide” from the “Site” drop-down menu. This will open the “Change Link Sitewide” dialog box. In the “Change all links to” text field, type in the OLD hyperlink destination. Next, in the “Into links to” text field, type the NEW hyperlink destination, and click “OK.” Dreamweaver will replace all of your old links with the new link. A dialog box will appear, asking you to confirm the changes. Click “OK.”
12.3 – FINDING AND REPLACING TEXT:

In this lesson, you will learn how to use Dreamweaver’s “Find and Replace” feature to change text that appears on more than one page of your website. This feature is especially helpful if you want to update copyright information, a date, or some other text that is found on multiple areas of your site.

First, choose “Find and Replace” from the “Edit” drop-down menu found in the Menu Bar. This will open the “Find and Replace” dialog box. If you want to search your entire site, make sure that the “Find in:” text field is set to “Entire Current Local Site.” Make sure the “Search” text field is set to “Text.” Next, in the “Find” text field, type in the text that you want to replace; and then, in the “Replace” text field, type in your new text. Then click “Replace All.” If you get a pop-up box asking if you’d like to replace text in unopened documents, click “Yes.” You will see that Dreamweaver replaces the old text with your new text, and the “Reports” panel will display details of the find and replace action, including a list of all of the files that had text replaced.
12.4 – SITE REPORTS:

In this lesson, you will learn how to run various site reports as part of website management. Back in the lesson “When is My Site Ready to Publish?” we discussed the importance of running a site report before putting your files onto a remote server. Once your site is up and running, you will use site reports to identify and resolve problems on your site. Let’s look at some different site reports that you can use to maintain your site.

First, choose “Reports…” from the “Site” drop-down menu found in the Menu Bar. This will open the “Reports” dialog box. As you can see, there are a variety of different reports that you can run using this dialog box. In the “Report On” text field, you can select to run a report on the entire current local site, or just the current document, or even a specific folder. Once you’ve decided which files you want to run a report on, check one or more boxes in the “Select Reports” window, depending on what kind of site report data you want. Let’s look for any untitled documents on our site. Click the “Untitled documents” checkbox, and then click “Run.” You will see the “Site Reports” panel update you as your files are checked, and the word “complete” will appear at the bottom of the “Site Reports” panel when your report is finished.
12.5 – CHECKING FILES IN AND OUT:

In this lesson, you will learn about Dreamweaver’s “Check In/Check Out” system. This handy system helps to organize a site when more than one person is working on building that site. If you are building your website alone, it is not recommended that you check files in or out, because doing so can tax system resources.

Let’s look at how checking files in and out works. First, connect to your remote web server. The “Check In/Check Out” system will not function if you are not connected to the remote host. Next, choose “Manage Sites” from the “Site” drop-down menu found in the Menu Bar. The “Manage Sites” dialog box will appear. Click to highlight the website you want to work on, and then click “Edit.” This will open up the “Site Setup” dialog box. Click the word “Servers” on the left side of the dialog box, and then click on the name of the server to select it. This is the same server name that you chose when you were initially setting up your server information in the “Setting up a Remote Site” lesson. Next, click the “Edit Existing Server” icon found near the bottom of the “Site Setup” dialog box. This will open another dialog box. Click the “Advanced” tab. Next, click the “Enable file checkout” checkbox. In the “Check-out Name” text field, type your name. Then, in the “Email Address” text field, type your email address. Click “Save” and then click “Save” again in the “Site Setup” dialog box. Finally, click “Done” in the “Manage Sites” dialog box. You have now enabled the “Check In/Check Out” feature.

To check out a file once this feature has been enabled, click on the file name in the “Files” panel, then right-click and select “Check Out.” You will be able to work on the file, Dreamweaver will mark the file as “checked out,” and nobody else will be able to access this file while you are working on it.

To check a file back in once you are finished working with it, simply click on the file name within the “Files” panel, then right-click and select “Check In.”
12.6 – USING DESIGN NOTES:

In this lesson, you will learn how to use Dreamweaver’s “Design Notes” feature. This handy tool allows you to make notes about the development of your web pages, which is especially helpful if you are working with more than one person to build your website.

Let’s look at how Design Notes work. First, choose “Design Notes...” from the “File” drop-down menu in the Menu Bar. This will open the “Design Notes” dialog box. To the right of the word “Status,” you can use the downward-pointing arrow to choose a status for your site, such as “Needs Attention.” Next, click the calendar “Date” icon to enter the current date in the “Notes” text field. You can also type in any additional information that you need into this same field. When you are finished, you can click the “Show when file is opened” box, and the design notes will be displayed as soon as the file is opened. Next, click “OK.” Your note will be attached to the page, and the next person to open the file will see the note immediately.

When you open a file that contains a Design Note, you will see the note before the file even becomes visible. Once you have read the Design Note, simply click “OK” to close the “Design Notes” dialog box, and you can begin working with the file as usual.
**ADD FAVORITES TO SITE ASSETS:**

1. Check “Assets” from the “Window” drop-down menu in the Menu Bar to open the “Assets” panel.
2. Enlarge the “Assets” panel so that its contents are fully visible.
3. Use the icons on the left side of the panel to select between types of content.
4. Click to select an element within the “Assets” panel.
5. Click the “Add to Favorites” icon in the bottom right corner of the “Assets” panel.

**CHANGING A LINK SITE-WIDE:**

1. Choose “Change Link Sitewide” from the “Site” drop-down menu in the Menu Bar. This will open the “Change Link Sitewide” dialog box.
2. In the “Change all links to” text field, type in the OLD hyperlink destination.
3. In the “Into links to” text field, type in the NEW hyperlink destination.
4. Click “OK.”
5. A dialog box will appear, asking you to confirm changes. Click “OK.”

**FINDING AND REPLACING TEXT**

1. Choose “Find and Replace” from the “Edit” drop-down menu in the Menu Bar. This will open the “Find and Replace” dialog box.
2. If you want to search your entire site, set the “Find In” text field to “Entire Current Local Site.”
3. Set the “Search” text field to “Text.”
4. In the “Find” text field, type in the text that you want to replace.
5. In the “Replace” text field, type in your new text.
6. If you get a pop-up box asking if you want to replace text in unopened documents, click “Yes.”

**RUNNING SITE REPORTS**

1. Choose “Reports” from the “Site” drop-down menu in the Menu Bar. This will open the “Reports” dialog box.
2. In the “Report On” text field, select between the entire site, the current document, or a site folder.
3. Check one or more boxes in the “Select Reports” area of the dialog box.
4. Click “Run.”
Purpose:
1. There are no exercises for this chapter.

Exercises:
1. None.
CHAPTER 13-
ADOBE BRIDGE

13.1- The Adobe Bridge Environment
13.2- Display Options
13.3- Compact Mode
13.4- Navigating, Opening & Placing Files
13.5- Searching for Files and Folders
13.6- Labeling and Rating Files
13.7- Sorting and Filtering Files
13.8- Copying, Moving and Deleting Files
13.9- Stacking and Unstacking
13.10- Previewing Images and the Loupe Tool
13.11- Rotating Images
13.12- Viewing a Slideshow
13.13- Viewing and Editing Metadata
13.14- Keywords
Adobe Bridge

13.1- The Adobe Bridge Environment:

Adobe Bridge (Photoshop CS2 and later) is command central for Adobe applications. Bridge is a powerful organizational tool that allows you to organize, share and manage project files, applications, settings and more. Adobe Bridge, which is included with Adobe’s Creative Suite applications (Dreamweaver, Flash, Illustrator, etc.) lets you easily store, search, preview and locate both Adobe and non-Adobe files you use in your work. For example, an image that you prepare in Photoshop for viewing on your Web site, can be stored in Bridge, then easily found and accessed when creating the HTML page in Dreamweaver – all using Bridge.

You can open Bridge from any Adobe application (except Acrobat). Select “File|Browse in Bridge...” from the Menu Bar. Bridge will open in its own window. You can also quickly go to Bridge by clicking the “Launch Bridge” button in the Applications Bar in CS5 and CS4 or the right end of the Options Bar in earlier versions.

The picture below is of the initial screen when you open Adobe Bridge. If you are used to a typical Windows environment, you will have some familiar tools available to you. Let’s take a moment to acquaint ourselves with the various parts of the environment, and what we can do through those objects.

At the top of the program window, we have the Title Bar which shows the icon “BR” of the application. At the right end are the three buttons that allow us to control the size and shape of the application window: “Minimize,” “Maximize/Restore” and “Close.” Note that when you click those buttons, they control the sizing of the entire application, not just the image file upon which you happen to be working.

![Adobe Bridge Interface](image-url)

- **Title Bar**
- **Navigation Controls**
- **Workspace Switcher Bar**
- **Preview Panel**
- **Metadata & Keywords Panels**
- **Thumbnail Preview Slider**
- **Content Panel**
- **Filter, Collections & Export Panels**
13.1- The Adobe Bridge Environment (cont.):

Below the Title Bar is the Menu Bar. This contains the commands for performing tasks in Bridge, grouped by category. For example, the “File” command contains all of the necessary commands for file management. You can click on one of the commands in the Menu Bar to display a drop-down listing of the subcommands that are available to perform. You then click on the command that you want to perform. Some subcommands are followed by a right-pointing arrow (►). That indicates that you must make a selection to execute that command. Simply hold your mouse pointer over those commands until you see a side-menu appear. Then slide your mouse pointer into the side menu to click on one of the available command choices.

Some commands are followed by an ellipsis mark (...). Those commands will then launch a dialog box when clicked into which you must input additional information or make a selection before you can execute that command. For example, if you selected “Edit| Find…” from the Menu Bar, you will be presented with the “Find” dialog box, where you would enter information to help you locate the file you are looking for. In the dialog boxes that do appear, you can click the “Cancel” button or press the “Esc” key on your keyboard to cancel the window without making a choice.

If you are interested in simply becoming a faster user of the Bridge program, then it will help you to memorize the keyboard shortcuts that are available for the various commands in the Menu Bar. Using the Menu Bar to begin also will allow you to view the various keyboard shortcuts. Keyboard shortcuts are listed to the right of the various commands in the Menu Bar drop-down menus. For example, if I wanted to view the “Find” dialog box again, I could press the “Ctrl” and “F” keys on my keyboard to make it appear more quickly in the future. You can see the keyboard shortcut “Ctrl+F” to the right of the “Find…” command in the “Edit” Menu Bar command’s drop-down menu.

Below the Menu Bar is a Shortcuts Bar, which allows you to easily navigate folders by clicking the left and right arrows, “Revealing Recent Files,” switching back to the Photoshop (or other) application, “Get Photos from Camera” and other options we will cover in upcoming lessons.

To the right is the Workspace Switcher Bar that allows you to easily switch in and out of various workspaces, and below that you can see a “trail of breadcrumbs” indicating the location of the image you are working on. In versions prior to CS4, there was the “Look In” Menu. You can expand and collapse this list by clicking on the small grey dots to the left of “Essentials” until your cursor turns into a line with arrows pointing left and right. Click and drag to expand or collapse the menu as needed. Just click on the name of the workspace, or use the drop-down menu at the right-end of the list to select the workspace you want.

The main workspace of the Bridge application consists of three panes that contain various panels. These panels can be moved and resized to suit your needs. You can move a panel from one pane to another by clicking on the name of the panel and dragging it to its new desired location. You can also resize the panels by clicking and dragging on any of the panel divider bars. You can hide or show any of the panels by selecting “Window” and then the panel name from the Menu Bar to check (view) or uncheck (hide) the panel. In CS5 and CS4, you can collapse and expand panels by double-clicking on the panel’s name tab.

The Favorites Panel (which you select by clicking on the panel’s name) provides quick and easy access to folders. You can add favorites by clicking and dragging them from the Content Panel display into the Favorites Panel. Or, select the image in the Content Panel and then select “File| Add to Favorites” from the Menu Bar. You can remove an item from your Favorites Panel by doing the reverse and selecting “File| Remove From Favorites” from the Menu Bar.
13.1- The Adobe Bridge Environment (cont.):

The Folders Panel displays folder hierarchy for navigation purposes. Click on any folder name and its contents will appear in the Content Panel display area. This is where files you choose in the Look In Menu, Favorites or Folder Panels are displayed. You can easily change the size of the thumbnails displayed by using the Thumbnail Preview Slider in the bottom-right corner of the application.

The Filter Panel allows you to sort files that are displayed in the Content Panel. Use the small arrows to collapse or expand your choices, and click on a “File Type” or “Keyword” listed to filter the display. You can also use the “Sort by” drop-down (located under the Workspace Switcher Bar) to filter by resolution, date created and many other choices.

When you select a file by clicking on it in the Content Panel, it is displayed for you in the Preview Panel, providing you with an image bigger than the thumbnail. In addition, information regarding that file is displayed in the Metadata Panel, including the file name, document size, resolution, etc. If you have more than one image selected, only data shared by the selected images will be displayed. The Keywords Panel will display any keywords you have attached to your file, which can also help with organization. For example, you may wish to attach the keyword “Wedding” to images from that event, which can then easily be filtered on and located later. You can navigate through files on your computer using the navigation controls just below the Menu Bar.

Switching in and out of workspaces is easy. You simply click on the workspace of your choice in the Workspace Switcher Bar. After re-arranging your workspace to your liking, you can save your customized workspace, by selecting “Window| Workspace| New Workspace...” from the Menu Bar. This will launch the “New Workspace” dialog box. Enter a name for your workspace. When you are done, click “Save” and the next time you go to “Window| Workspace...” from the Menu Bar, your new space will be listed as a selection. You can also choose one of the preconfigured workspaces that come with the Bridge application, if you prefer, by selecting those from the same “Workspace” menu. If you wish to revert back to the default workspace, select “Window| Workspace| Reset to Default Workspace” from the Menu Bar.

It’s important to keep your files organized so that you can easily locate them when you need to. Bridge gives you an easy way to keep your images organized by using Collections. Once you get your images into Bridge, you can group them into Collections, stored in the Collections Panel.

To create a new Collection and add images to it in Bridge, click on the “New Collection” button at the bottom of the Collections Panel and type a name in the text box. Then, simply click and drag images from the Content Panel onto the Collection name. When you click on that Collection, only images assigned to it will be displayed. If you right-click on the Collection, you will be presented with a contextual menu where you can re-name, delete and modify the Collection.

You can create a “Smart Collection” which allows you to select criteria for images to be included, instead of having to manually select the images. Smart Collections are automatically updated as matching criteria are added to your images. For example, you could have one of your criteria be a certain file type. As you add files of that type, those images will automatically be added to your Smart Collection.

To create a Smart Collection, select the “New Smart Collection” button. In the “Smart Collection” dialog box, use the controls to set the parameters of your Collection and click “Save.” Then, enter a name for your Smart Collection in the text box. Bridge will scan files meeting the criteria you chose in order to add the images to the Collection.

When you are done working in Bridge, you can return to the Photoshop application (or any Adobe application you were in to link to Bridge) by selecting “File| Return To (application)” from the Menu Bar.
13.2- Display Options:

By default, Adobe Bridge displays your files and folders in the Content panel in the form of thumbnails. You can easily adjust the size of the thumbnails displayed by using the Thumbnail Preview Slider at the bottom of the Bridge window. Click on the slider control and move it to the left to decrease the size of the thumbnails, and to the right to make them larger.

You can also choose to display more or less information with your thumbnails. Select “View| As Thumbnails” from the Menu Bar to view the thumbnails with the file or folder names below them. Select “View| As Details” to display the thumbnails with additional information, such as dates created and edited, and file types. You can also choose “View| As List” to change the display to layout mode. In CS5 and CS4, these functions can also be found just to the right of the Thumbnail Slider Bar.

13.3- Compact Mode:

Compact Mode shrinks the Adobe Bridge window and allows it to float above all applications (instead of sitting behind them in a traditional Windows format). This can be helpful if you are accessing several files from Bridge in another application such as Photoshop. Switch to Compact Mode by selecting “View| Compact Mode” from the Menu Bar, or by clicking the “Switch to Compact Mode” button at the far-right end of Bridge. Once in Compact Mode, a pop-up menu (accessible by clicking the downward-pointing arrow in the floating compacted Bridge window) provides you with a subset of common commands. You can switch back to Full Mode by clicking that button next to the drop-down menu.
13.4- Navigating, Opening & Placing Files:

You navigate through the various files and folders in Bridge the same way you do in other applications. Click a file to highlight and select it. Double-click a folder to enter it and view the contents. You can also use the Go Back or Go Forward buttons to help you navigate, if you wish.

To open a file, double-click the file or select it and choose “File| Open” from the Menu Bar. You can also select a file and place it directly into an Adobe application. After selecting the file, choose “File| Place” followed by the application name to place the file.
13.5- Searching for Files and Folders:

Searching for files and folders in Bridge is performed via the Edit command (or the “Search” box in the upper-right corner of Bridge in CS5 & CS4). Choose “Edit| Find” from the Menu Bar to launch the “Find” dialog box. This box provides you with many different criteria you can use (in different combinations) to search.

When the “Find” dialog box launches, first select a folder using the “Look in:” drop-down. Then, choose your search criteria using the drop-down menus to make your choices. Add search criteria by clicking the plus sign, and remove a criteria using the minus sign. Use the “Match” drop-down to select whether you want any or all of the criteria conditions to be met. Optionally, you can click “Include All Subfolders,” which will expand your search into any subfolders within the folder you are looking in. By default, Bridge only searches folders that you have already opened in Bridge (cached). If you select “Include Non-indexed Files,” you will search all files within the specified folders. When you are ready, click the “Find” button to begin your search. Your results will be displayed in the Content window. You can begin your search again, by clicking the “Search Again” or “New Search” button that appears in the upper-right corner of the Content window, or cancel the search by clicking the “X” in the upper right corner.

![Find dialog box in Adobe Bridge](image)
13.6- Labeling and Rating Files:

Assigning labels (colors) or ratings (1 to 5 stars) to your files and folders further helps you organize your work in Adobe Bridge. Once you’ve assigned labels or ratings, you can sort and search for files based on the criteria you applied.

To assign a rating, first select the file or folder. You can assign ratings to multiple files at the same time. Select multiple files by holding down the “Ctrl” button on your keyboard and clicking the files to select them. Then, choose “Label” from the Menu Bar, followed by the rating you wish to assign. You can increase or decrease ratings in increments of one star per click by selecting “Increase Rating” or “Decrease Rating” from the Label menu. You can also assign and change ratings by clicking on the corresponding dots below the thumbnails of the files. Clicking to the left of all of the dots removes the rating completely. If you see a shortcut representation of your star rating (that is, 4 instead of four stars in a row) simply increase the size of your thumbnails by using the slider.

To assign a color label, follow the same procedure to select your desired files, then choose “Label” from the Menu Bar, followed by “Select” (Red), “Second” (Yellow), “Approved” (Green), “Review” (Blue), or “To Do” (Purple).

To remove a label, select the file and choose “Label| No Label” from the Menu Bar.
13.7- Sorting and Filtering Files:

You can sort the files displayed in the Content window. Select “View|Sort” from the Menu Bar, followed by your desired sort criteria. Choosing “Manually” will sort the files in the order in which they were placed in Bridge. You can also use the “Sort” drop-down in the upper-right corner of Bridge to display your sort choices.

You can also use the Filter panel to display certain files you choose. In the Filter panel, select (by clicking on) any of the available criteria to display those files in the Content window. You can hold down the “Shift” key on your keyboard and select a criteria to choose that rating and higher. For example, if you hold down “Shift” and click on a rating of two stars, you will display files with a rating of two stars or higher.

You can clear selected filters by clicking the “Clear Filter” button at the bottom-right of the Filter panel. If you wish to keep from clearing the filters while looking in other parts of Bridge, select the “Keep Filter When Browsing” button in the lower-left corner of the Filter panel to lock the filters.
13.8- Copying, Moving and Deleting Files:

You can copy files or folders by selecting the file(s) and then choosing “Edit| Copy” from the Menu Bar. You can also right-click on a file and select “Copy To,” followed by your desired location. Another option to copy your file is to hold down the “Ctrl” button and drag the file into your desired location, which will make a copy of it.

To move a file, right-click the file and choose “Move To,” followed by your desired location. You can also simply click and drag a file into a new location to move it without making a copy.

To delete a file, simply select it and then click the “Delete” button in the upper-right corner of the Bridge application.

You can manage (move, rename, etc.) files easily in batches (groups) in Bridge. To do so, select the files and choose “Tools| Batch Rename” from the Menu Bar. In the “Batch Rename” dialog box, select your options and click “Rename.”

13.9- Stacking and Unstacking:

Stacks are another organizational tool that Bridge provides. When you assign files to a stack, only the top file is displayed in the Content window, while all of the other associated files are kept behind it (similar to a stack of playing cards). Further, you can expand and collapse stacks to perform various tasks. Commands that you apply to an expanded stack apply to all of the files in the stack. If the stack is collapsed, only the top file is changed when you apply the command. To create a stack, choose your files, choose “Stacks| Group As Stack” from the Menu Bar. The first file you selected will become the thumbnail for the stack. A number on that thumbnail tells you how many files are contained in the stack. Expand and collapse individual stacks by clicking on the stack’s number in the Content window, or work with all stacks by selecting “Stacks| Expand All Stacks” or “Stacks| Collapse All Stacks” from the Menu Bar.

You can change which file is used as the thumbnail for the stack by right-clicking the file and selecting “Stack| Promote To Top Of Stack” from the side menu that appears. To unstack, select your stack and choose “Stacks| Ungroup From Stacks” from the Menu Bar.
13.10- Previewing Images and the Loupe Tool:

When you select an image in Bridge, you can display it in the Preview Panel, which displays a larger image of the file. If the Panel is not turned on, select your image and choose “Window| Preview Panel” from the Menu Bar. You can display multiple images in the Preview panel by Control-clicking the images in the Content panel.

The Loupe tool magnifies portions of an image in the Preview panel. To display the Loupe tool, click an image in the Preview panel and use the Hand tool to move the magnifier around the image. You can zoom in and out with the Loupe tool by using your mouse scroll wheel or by clicking the plus or minus signs on your keyboard. If you have multiple images displayed in the Preview panel, you can open a Loupe tool for each image. To close a Loupe tool, simply click in the middle of it.

13.11- Rotating Images:

You can rotate an image (JPEG, PSD, TIFF and camera raw files) in Bridge to change how it is displayed in the Content window. To do so, select the image and select “Edit| Rotate 180º,” “Edit| Rotate 90º Clockwise,” or “Rotate| 90º Counterclockwise” from the Menu Bar.

13.12- Viewing a Slideshow:

Bridge provides another way to view images via a Slideshow that encompasses the entire screen. To run a slide show, select the images you want to display, and choose “View| Slideshow” from the Menu Bar. Once the slideshow begins, you can press “H” on your keyboard to display various command options that change how your slideshow is displayed. Press “H” again to hide the command options. You can also press “L” or select “View| Slideshow Options...” from the Menu Bar to display other slideshow options. Clicking the Escape button will exit Slideshow.

13.13- Viewing and Editing Metadata:

Metadata is a set of standardized information related to a file. It can contain information such as the author’s name, resolution, copyright information and much more. When you select a file, its metadata is displayed in the Metadata panel. If the panel is not on, display it by selecting “Window| Metadata Panel” from the Menu Bar. You can edit metadata in the Metadata panel by clicking on the pencil icon to the far right of the metadata field you wish to edit. Type the information into the text box. Press the “Tab” key to move through the various metadata fields. When you are done, click the “Apply” (small checkmark) button at the bottom of the Metadata panel, or the “Cancel” button to cancel changes you’ve made.

You can also add metadata information to a file using the Menu Bar. Select the file and choose “File| File Info” from the Menu Bar. In the “File Info” dialog box that appears, click on any of the types of metadata to display choices to add data to that file. When you are done, click “OK.”
13.14- Keywords:

You can assign keywords to files in Bridge, which further helps you organize, sort and find your files for later use. Keywords are displayed in the Keywords panel. Keywords can take the form of people, places, events, or just about anything you wish. To assign a keyword or keyword set to a file, select the file(s) in the Content window and click the checkbox in the Keyword panel, to the left of the keyword or set that you want to apply. To remove it, simply uncheck the box.

You can also create new keywords and sub-keywords. Select either the "New Keyword" or the "New Sub Keyword" from the panel menu that appears when you click the "More Options" button in the upper-right corner of the panel. From this menu, you can also manage (rename, move, delete) keywords.

![Keywords Panel in Adobe Bridge]
ACTIONS-
Adobe Bridge

TO OPEN ADOBE BRIDGE FROM AN ADOBE APPLICATION:
1. Click the “Go to Bridge” button at the right-end of the options bar (CS3 and higher).

OR

1. Select “File| Browse (in Bridge)…” from the Menu

TO CHANGE DISPLAY OPTIONS:

1. To change the size of the thumbnails being displayed, click on the slider control in the bottom-right corner of the application, and move to the left for smaller images, and to the right for larger.
2. To change the display options, select “View| As Thumbnails,” “View| As Details,” or “View| As Thumbnails Only” from the Menu Bar.

TO SWITCH INTO COMPACT MODE:

1. Select “View| Compact Mode” from the Menu Bar.

OR

1. Click the “Switch to Compact Mode” button in the upper-right corner of the Bridge application. (Click the “Full Mode” button to switch back.)

TO OPEN AND PLACE A FILE IN AN ADOBE APPLICATION FROM BRIDGE:

1. Double-click the file to open it, or select it and choose “File| Open” from the Menu Bar.
2. To place a selected file, choose “File| Place” (followed by the application name) from the Menu Bar.
TO SEARCH FOR FILES AND FOLDERS AND SAVE A COLLECTION:
1. Select “Edit| Find” from the Menu Bar to launch the “Find” dialog box.
2. Use the drop-downs to select your search criteria.
3. Click “Find.”
4. To save the search as a Collection, click the “Save As Collection” button.
5. Enter a name in the dialog box for your Collection and click “Save.”

TO LABEL AND RATE FILES:
1. Select the file or folder you wish to label or rate (hold down the “Ctrl” button on your keyboard to select multiple items).
2. Select “Label”, followed by the rating or label you wish to assign, from the Menu Bar.
3. To remove a label, select the file(s)/folder(s) and choose “Label| No Label” from the Menu Bar.

TO SORT AND FILTER FILES:
1. Select “View| Sort” from the Menu Bar, followed by your sort choice in the side menu.
2. To filter files, click on the any of the available criteria in the “Filter” panel to display the results.
3. To clear filters, click the “Clear Filter” button at the bottom-right of the “Filter” panel.

TO COPY FILES:
1. To copy a file or folder, select it and choose “Edit| Copy” from the Menu Bar.

OR
1. Right-click on the file or folder and choose “Copy To” followed by your desired location.

OR
1. Hold down the “Ctrl” key on your keyboard and drag the file or folder to the desired location to make a copy.
TO MOVE OR DELETE A FILE OR FOLDER:

1. To delete a file or folder, select it and click the “Delete” button in the upper-right corner of the Bridge application.
2. To move a file or folder, right-click it and choose “Move To,” followed by your desired location.

OR

1. Click and drag it to a new location.

TO STACK AND UNSTACK FILES:

1. Select your files and choose “Stacks| Group As Stack” from the Menu Bar.
2. To expand and collapse the stacks, click on the stack’s number in the Content window, or work with all stacks by selecting “Stacks| Expand All Stacks” or “Stacks| Collapse All Stacks” from the Menu Bar.
3. To promote a file to the top of the stack, right-click the file and select “Stack| Promote To Top Of Stack” from the side menu that appears.
4. To unstack, select the stack and choose “Stacks| Ungroup From Stacks” from the Menu Bar.

TO USE THE LOUPE TOOL:

1. Select your image to preview.
2. Click the image in the Preview panel.
3. Use the Hand tool to move the magnifier around the image.
4. Zoom in and out using your mouse scroll wheel or by clicking the plus and minus signs on your keyboard.
5. To close the Loupe tool, click in the middle of it.

TO ROTATE AN IMAGE:

1. Select your image.
2. Choose “Edit| Rotate,” followed by the direction and degree of your choice.

TO VIEW A SLIDESHOW:

1. Select the images you wish to display.
2. Choose “View| Slideshow” from the Menu Bar.
3. Select “View| Slideshow Options…” from the Menu Bar to display various options for viewing.
TO VIEW AND EDIT METADATA:
1. Select your file and choose “Window| Metadata Panel” from the Menu Bar to view the current metadata.
2. Edit the metadata by clicking on the pencil icon at the far-right of the field you wish to modify and type the new information in the text box, then click “Apply.”

TO ADD METADATA TO A FILE:
1. Select your file and choose “File| File Info” from the Menu Bar.
2. In the “File Info” dialog box, click on any of the types of metadata in the left panel and add your choices.
3. Click “OK.”

TO ADD KEYWORDS TO FILES:
1. Select the file(s) to which you wish to add keywords/keyword sets.
2. Click the checkbox to the left of the keyword or keyword set you wish in the Keyword pane.
**EXERCISES-Adobe Bridge**

**Purpose:**
1. To be able to view, find, sort and manage files in Adobe Bridge.

**Exercises:**

1. Open your Adobe Bridge application.
2. If no files have been added, select “File| Open” from the Menu Bar and open some sample files to work with.
3. Select “View| As Thumbnails Only” from the Menu Bar.
4. Use the slider control to change the size of the thumbnails displayed.
5. Select an image and choose “Label ****” from the Menu Bar (four stars).
6. In the Filter panel, click on the four-star rating to filter for images tagged with four stars.
7. Click the four-star rating again to clear the filter.
8. Choose three different files and select “Stacks| Group As Stack” from the Menu Bar.
9. Click on the “3” on the stack in the Content window to expand the stack.
10. Right-click one of the two images not being used as the top image and choose “Stack| Promote To Top Of Stack” from the side menu.
11. Click the “3” again to collapse the stack.
12. Select “Stacks| Ungroup From Stacks” to unstack the images.
13. Select an image to preview.
14. Click on the image in the Preview panel to use the Loupe tool.
15. Press + and – on your keyboard to zoom in and out.
16. Click in the middle of the Loupe tool.
17. With the same image selected, choose “Edit| Rotate 180°” from the Menu Bar.
18. Select a file and click “New York” in the Keywords panel.
### Dreamweaver Keyboard Shortcuts

<table>
<thead>
<tr>
<th><strong>“File” Shortcuts</strong></th>
<th><strong>Key</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td>New Document</td>
<td>Ctrl + N</td>
</tr>
<tr>
<td>Open…</td>
<td>Ctrl + O</td>
</tr>
<tr>
<td>Open in Frame…</td>
<td>Ctrl + Shift + O</td>
</tr>
<tr>
<td>Close</td>
<td>Ctrl + W</td>
</tr>
<tr>
<td>Close All</td>
<td>Ctrl + Shift + W</td>
</tr>
<tr>
<td>Save</td>
<td>Ctrl + S</td>
</tr>
<tr>
<td>Save All</td>
<td>Ctrl + Shift + S</td>
</tr>
<tr>
<td>Print Code</td>
<td>Ctrl + P</td>
</tr>
<tr>
<td>Check Links</td>
<td>Shift + F8</td>
</tr>
<tr>
<td>Validate Markup</td>
<td>Shift + F6</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th><strong>“Edit” Shortcuts</strong></th>
<th><strong>Key</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td>Undo</td>
<td>Ctrl + Z</td>
</tr>
<tr>
<td>Redo</td>
<td>Ctrl + Y</td>
</tr>
<tr>
<td>Cut</td>
<td>Ctrl + X</td>
</tr>
<tr>
<td>Copy</td>
<td>Ctrl + C</td>
</tr>
<tr>
<td>Paste</td>
<td>Ctrl + V</td>
</tr>
<tr>
<td>Copy HTML</td>
<td>Ctrl + Shift + C</td>
</tr>
<tr>
<td>Paste HTML</td>
<td>Ctrl + Shift + V</td>
</tr>
<tr>
<td>Select All</td>
<td>Ctrl + A</td>
</tr>
<tr>
<td>Select Parent Tag</td>
<td>Ctrl + [</td>
</tr>
<tr>
<td>Select Child Tag</td>
<td>Ctrl + ]</td>
</tr>
<tr>
<td>Find and Replace…</td>
<td>Ctrl + F</td>
</tr>
<tr>
<td>Find Selection</td>
<td>Shift + F3</td>
</tr>
<tr>
<td>Find Next</td>
<td>F3</td>
</tr>
<tr>
<td>Go to Line</td>
<td>Ctrl + G</td>
</tr>
<tr>
<td>Show Code Hints</td>
<td>Ctrl + Spacebar</td>
</tr>
<tr>
<td>Indent Code</td>
<td>Ctrl + Shift + &gt;</td>
</tr>
<tr>
<td>Outdent Code</td>
<td>Ctrl + Shift + &lt;</td>
</tr>
<tr>
<td>Balance Braces</td>
<td>Ctrl + ’</td>
</tr>
<tr>
<td>Preferences</td>
<td>Ctrl + U</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th><strong>“View” Shortcuts</strong></th>
<th><strong>Key</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td>Switch Views</td>
<td>Ctrl + `</td>
</tr>
<tr>
<td>Refresh Design View</td>
<td>F5</td>
</tr>
<tr>
<td>Server Debug</td>
<td>Ctrl + Shift + G</td>
</tr>
<tr>
<td>Head Content</td>
<td>Ctrl + Shift + H</td>
</tr>
<tr>
<td>Expanded Tables Mode (2004)</td>
<td>F6</td>
</tr>
<tr>
<td>Layout Mode</td>
<td>Ctrl + F6</td>
</tr>
<tr>
<td>Hide All (Visual Aids)</td>
<td>Ctrl + Shift + I</td>
</tr>
<tr>
<td>Show Rulers</td>
<td>Ctrl + Alt + R</td>
</tr>
<tr>
<td>Show Grid</td>
<td>Ctrl + Alt + G</td>
</tr>
<tr>
<td>Snap to Grid</td>
<td>Ctrl + Alt + Shift + G</td>
</tr>
<tr>
<td>Play Plugin</td>
<td>Ctrl + Alt + P</td>
</tr>
<tr>
<td>Stop Playing Plugin</td>
<td>Ctrl + Alt + X</td>
</tr>
<tr>
<td>Play All</td>
<td>Ctrl + Alt + Shift + P</td>
</tr>
<tr>
<td>Stop All</td>
<td>Ctrl + Alt + Shift + X</td>
</tr>
<tr>
<td>Show Panels</td>
<td>F4</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th><strong>“Insert” Shortcuts</strong></th>
<th><strong>Key</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td>Insert Tag</td>
<td>Ctrl + E</td>
</tr>
<tr>
<td>Insert Image</td>
<td>Ctrl + Alt + I</td>
</tr>
<tr>
<td>Insert Flash</td>
<td>Ctrl + Alt + F</td>
</tr>
<tr>
<td>Insert Shockwave</td>
<td>Ctrl + Alt + D</td>
</tr>
<tr>
<td>Insert Table</td>
<td>Ctrl + Alt + T</td>
</tr>
<tr>
<td>Insert Named Anchor</td>
<td>Ctrl + Alt + A</td>
</tr>
<tr>
<td>Insert Line Break</td>
<td>Shift + Return</td>
</tr>
<tr>
<td>Non-Breaking Space</td>
<td>Ctrl + Shift + Space</td>
</tr>
<tr>
<td>Insert Editable Region</td>
<td>Ctrl + Alt + V</td>
</tr>
</tbody>
</table>
## Dreamweaver Keyboard Shortcuts

### “Modify” Shortcuts

<table>
<thead>
<tr>
<th>Action</th>
<th>Key</th>
</tr>
</thead>
<tbody>
<tr>
<td>Page Properties</td>
<td>Ctrl + J</td>
</tr>
<tr>
<td>Quick Tag Editor</td>
<td>Ctrl + T</td>
</tr>
<tr>
<td>Make Link...</td>
<td>Ctrl + L</td>
</tr>
<tr>
<td>Remove Link</td>
<td>Ctrl + Shift + L</td>
</tr>
<tr>
<td>Select Table</td>
<td>Ctrl + A</td>
</tr>
<tr>
<td>Merge Cells</td>
<td>Ctrl + Alt + M</td>
</tr>
<tr>
<td>Split Cell...</td>
<td>Ctrl + Alt + S</td>
</tr>
<tr>
<td>Insert Row</td>
<td>Ctrl + M</td>
</tr>
<tr>
<td>Insert Column</td>
<td>Ctrl + Shift + A</td>
</tr>
<tr>
<td>Delete Row</td>
<td>Ctrl + Shift + M</td>
</tr>
<tr>
<td>Delete Column</td>
<td>Ctrl + Shift + -</td>
</tr>
<tr>
<td>Increase Column Span</td>
<td>Ctrl + Shift + ]</td>
</tr>
<tr>
<td>Decrease Column Span</td>
<td>Ctrl + Shift + [</td>
</tr>
<tr>
<td>Left Align Cell</td>
<td>Ctrl + Shift + 1</td>
</tr>
<tr>
<td>Right Align Cell</td>
<td>Ctrl + Shift + 3</td>
</tr>
<tr>
<td>Top Align Cell</td>
<td>Ctrl + Shift + 4</td>
</tr>
<tr>
<td>Bottom Align Cell</td>
<td>Ctrl + Shift + 6</td>
</tr>
<tr>
<td>Make Columns Same Width</td>
<td>Ctrl + Shift + 7</td>
</tr>
<tr>
<td>Make Rows Same Height</td>
<td>Ctrl + Shift + 9</td>
</tr>
<tr>
<td>Add Object to Timeline</td>
<td>Ctrl + Alt + Shift + T</td>
</tr>
</tbody>
</table>

### “Text” Shortcuts

<table>
<thead>
<tr>
<th>Action</th>
<th>Key</th>
</tr>
</thead>
<tbody>
<tr>
<td>Indent</td>
<td>Ctrl + Alt + ]</td>
</tr>
<tr>
<td>Outdent</td>
<td>Ctrl + Alt + [</td>
</tr>
<tr>
<td>No paragraph format</td>
<td>Ctrl + 0</td>
</tr>
<tr>
<td>Paragraph Format</td>
<td>Ctrl + Shift + P</td>
</tr>
<tr>
<td>Heading 1</td>
<td>Ctrl + 1</td>
</tr>
<tr>
<td>Heading 2</td>
<td>Ctrl + 2</td>
</tr>
<tr>
<td>Heading 3</td>
<td>Ctrl + 3</td>
</tr>
<tr>
<td>Heading 4</td>
<td>Ctrl + 4</td>
</tr>
<tr>
<td>Heading 5</td>
<td>Ctrl + 5</td>
</tr>
<tr>
<td>Heading 6</td>
<td>Ctrl + 6</td>
</tr>
<tr>
<td>Left Align Text</td>
<td>Ctrl + Alt + Shift + L</td>
</tr>
<tr>
<td>Center Align Text</td>
<td>Ctrl + Alt + Shift + C</td>
</tr>
<tr>
<td>Right Align Text</td>
<td>Ctrl + Alt + Shift + R</td>
</tr>
<tr>
<td>Justify Text</td>
<td>Ctrl + Alt + Shift + J</td>
</tr>
</tbody>
</table>

### “Style” Shortcuts

<table>
<thead>
<tr>
<th>Action</th>
<th>Key</th>
</tr>
</thead>
<tbody>
<tr>
<td>Bold</td>
<td>Ctrl + B</td>
</tr>
<tr>
<td>Italic</td>
<td>Ctrl + I</td>
</tr>
<tr>
<td>Check Spelling</td>
<td>Shift + F7</td>
</tr>
</tbody>
</table>

### “Commands” Shortcuts

<table>
<thead>
<tr>
<th>Action</th>
<th>Key</th>
</tr>
</thead>
<tbody>
<tr>
<td>Start Recording</td>
<td>Ctrl + Shift + X</td>
</tr>
</tbody>
</table>

### “Site” Shortcuts

<table>
<thead>
<tr>
<th>Action</th>
<th>Key</th>
</tr>
</thead>
<tbody>
<tr>
<td>Get</td>
<td>Ctrl + Shift + D</td>
</tr>
<tr>
<td>Check Out</td>
<td>Ctrl + Alt + Shift + D</td>
</tr>
<tr>
<td>Put</td>
<td>Ctrl + Shift + U</td>
</tr>
<tr>
<td>Check In</td>
<td>Ctrl + Alt + Shift + U</td>
</tr>
<tr>
<td>Check Links Sitewide</td>
<td>Ctrl + F8</td>
</tr>
</tbody>
</table>

### “Window” Shortcuts

<table>
<thead>
<tr>
<th>Action</th>
<th>Key</th>
</tr>
</thead>
<tbody>
<tr>
<td>Insert</td>
<td>Ctrl + F2</td>
</tr>
<tr>
<td>Properties</td>
<td>Ctrl + F3</td>
</tr>
<tr>
<td>CSS Styles</td>
<td>Shift + F11</td>
</tr>
<tr>
<td>Layers</td>
<td>F2</td>
</tr>
<tr>
<td>Behaviors</td>
<td>Shift + F4</td>
</tr>
<tr>
<td>Snippets</td>
<td>Shift + F9</td>
</tr>
<tr>
<td>Reference</td>
<td>Shift + F1</td>
</tr>
<tr>
<td>Databases</td>
<td>Ctrl + Shift + F10</td>
</tr>
<tr>
<td>Bindings</td>
<td>Ctrl + F10</td>
</tr>
<tr>
<td>Server Behaviors</td>
<td>Ctrl + F9</td>
</tr>
<tr>
<td>Components</td>
<td>Ctrl + F7</td>
</tr>
<tr>
<td>Files</td>
<td>F8</td>
</tr>
<tr>
<td>Assets</td>
<td>F11</td>
</tr>
<tr>
<td>Tag Inspector</td>
<td>F9</td>
</tr>
<tr>
<td>Results</td>
<td>F7</td>
</tr>
<tr>
<td>History</td>
<td>Shift + F10</td>
</tr>
<tr>
<td>Frames</td>
<td>Shift + F2</td>
</tr>
<tr>
<td>Code Inspector</td>
<td>F10</td>
</tr>
<tr>
<td>Timelines</td>
<td>Alt + F9</td>
</tr>
<tr>
<td>Show Panels</td>
<td>F4</td>
</tr>
</tbody>
</table>

### “Help” Shortcuts

<table>
<thead>
<tr>
<th>Action</th>
<th>Key</th>
</tr>
</thead>
<tbody>
<tr>
<td>Using Dreamweaver</td>
<td>F1</td>
</tr>
<tr>
<td>Using Cold Fusion</td>
<td>Ctrl + F1</td>
</tr>
<tr>
<td>Reference</td>
<td>Shift + F1</td>
</tr>
</tbody>
</table>
### "Site Panel" Shortcuts

<table>
<thead>
<tr>
<th>Key</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>Ctrl + Shift + N</td>
<td>New File</td>
</tr>
<tr>
<td>Ctrl + Alt + Shift + N</td>
<td>New Folder</td>
</tr>
<tr>
<td>F2</td>
<td>Rename</td>
</tr>
<tr>
<td>Del</td>
<td>Delete</td>
</tr>
<tr>
<td>Shift + F8</td>
<td>Check Links</td>
</tr>
<tr>
<td>Ctrl + D</td>
<td>Duplicate</td>
</tr>
<tr>
<td>F5</td>
<td>Refresh View</td>
</tr>
<tr>
<td>Ctrl + Shift + Y</td>
<td>Show/Hide Link</td>
</tr>
<tr>
<td>Ctrl + Shift + R</td>
<td>View as Root</td>
</tr>
<tr>
<td>Ctrl + Shift + T</td>
<td>Show Page Titles</td>
</tr>
<tr>
<td>F8</td>
<td>Site Files</td>
</tr>
<tr>
<td>Alt + F8</td>
<td>Site Map</td>
</tr>
<tr>
<td>Ctrl + Shift + N</td>
<td>Link to New File…</td>
</tr>
<tr>
<td>Ctrl + Shift + K</td>
<td>Link to Existing File…</td>
</tr>
<tr>
<td>Ctrl + L</td>
<td>Change Link…</td>
</tr>
<tr>
<td>Ctrl + Shift + L</td>
<td>Remove Link</td>
</tr>
<tr>
<td>Ctrl + F4</td>
<td>Close Window</td>
</tr>
<tr>
<td>Alt + F4</td>
<td>Quit Application</td>
</tr>
<tr>
<td>Enter</td>
<td>Open</td>
</tr>
<tr>
<td>F12</td>
<td>Preview in Primary Browser</td>
</tr>
<tr>
<td>Ctrl + F12</td>
<td>Preview in Secondary Browser</td>
</tr>
<tr>
<td>Esc</td>
<td>Cancel FTP</td>
</tr>
</tbody>
</table>

### "Code Editing" Shortcuts

<table>
<thead>
<tr>
<th>Key</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>Ctrl + Shift + Right</td>
<td>Select word to the right</td>
</tr>
<tr>
<td>Home</td>
<td>Move to start of line</td>
</tr>
<tr>
<td>End</td>
<td>Move to end of line</td>
</tr>
<tr>
<td>Shift + Home</td>
<td>Select to start of line</td>
</tr>
<tr>
<td>Shift + End</td>
<td>Select to end of line</td>
</tr>
<tr>
<td>Ctrl + Home</td>
<td>Move to top of file</td>
</tr>
<tr>
<td>Ctrl + End</td>
<td>Move to end of file</td>
</tr>
<tr>
<td>Ctrl + Shift + Home</td>
<td>Select to start of file</td>
</tr>
<tr>
<td>Ctrl + Shift + End</td>
<td>Select to end of file</td>
</tr>
<tr>
<td>Ctrl + Shift + Right</td>
<td>Select until Next Word</td>
</tr>
<tr>
<td>Ctrl + Shift + Left</td>
<td>Select from Previous Word</td>
</tr>
<tr>
<td>Ctrl + Shift + Up</td>
<td>Select from Previous Paragraph</td>
</tr>
<tr>
<td>Ctrl + Shift + Down</td>
<td>Select until Next Paragraph</td>
</tr>
<tr>
<td>Ctrl + Shift + Tab</td>
<td>Quit Application</td>
</tr>
<tr>
<td>Ctrl + Tab</td>
<td>New in Same Window</td>
</tr>
<tr>
<td>Ctrl + Shift + N</td>
<td>Preview in Primary Browser</td>
</tr>
<tr>
<td>F12</td>
<td>Preview in Secondary Browser</td>
</tr>
<tr>
<td>Shift + F12</td>
<td>Exit Paragraph</td>
</tr>
<tr>
<td>Ctrl + Enter</td>
<td>Live Data Mode</td>
</tr>
<tr>
<td>Ctrl + R</td>
<td>Print Code</td>
</tr>
<tr>
<td>Ctrl + P</td>
<td>Next Document</td>
</tr>
<tr>
<td>Ctrl + Tab</td>
<td>Previous Document</td>
</tr>
</tbody>
</table>

### "Document Editing" Shortcuts

<table>
<thead>
<tr>
<th>Key</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>Ctrl + Right Arrow</td>
<td>Go to Next Word</td>
</tr>
<tr>
<td>Ctrl + Left Arrow</td>
<td>Go to Previous Word</td>
</tr>
<tr>
<td>Ctrl + Up Arrow</td>
<td>Go to Previous Paragraph</td>
</tr>
<tr>
<td>Ctrl + Down Arrow</td>
<td>Go to Next Paragraph</td>
</tr>
<tr>
<td>Ctrl + Shift + Right</td>
<td>Select until Next Word</td>
</tr>
<tr>
<td>Ctrl + Shift + Left</td>
<td>Select from Previous Word</td>
</tr>
<tr>
<td>Ctrl + Shift + Up</td>
<td>Select from Previous Paragraph</td>
</tr>
<tr>
<td>Ctrl + Shift + Down</td>
<td>Select until Next Paragraph</td>
</tr>
<tr>
<td>Ctrl + Shift + Tab</td>
<td>Quit Application</td>
</tr>
<tr>
<td>Ctrl + Shift + N</td>
<td>Preview in Primary Browser</td>
</tr>
<tr>
<td>Shift + F12</td>
<td>Preview in Secondary Browser</td>
</tr>
<tr>
<td>Ctrl + Enter</td>
<td>Exit Paragraph</td>
</tr>
<tr>
<td>Ctrl + R</td>
<td>Live Data Mode</td>
</tr>
<tr>
<td>Ctrl + P</td>
<td>Print Code</td>
</tr>
<tr>
<td>Ctrl + Tab</td>
<td>Next Document</td>
</tr>
<tr>
<td>Ctrl + Shift + Tab</td>
<td>Previous Document</td>
</tr>
</tbody>
</table>